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Chapter 1

About this Guide

This Uset's Guide provides information on how to prepare custom Virtual Analyzer
images in the following topics:

. OVZA File Creation Using New VVirtnal Machine Images on page 2-1

OVA File Creation Using Converted Virtual Hard Disk Drives on page 3-1

Virtual Analyzer Image Preparation Tool on page 4-1
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Document Conventions

The documentation uses the following conventions:

TABLE 1-1. Document Conventions

CONVENTION DESCRIPTION
UPPER CASE Acronyms, abbreviations, and names of certain
commands and keys on the keyboard
Bold Menus and menu commands, command buttons, tabs,
and options
Italics References to other documents
Monospace Sample command lines, program code, web URLs, file

names, and program output

Navigation > Path

The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

ﬁ’ Note

Configuration notes

Q Tip

Recommendations or suggestions

O Important
L.

Information regarding required or default configuration
settings and product limitations

ﬁ WARNING!

Critical actions and configuration options




About this Guide

Audience

This User Guide is intended for administrators who need to create custom sandbox

images for Virtual Analyzer. The document assumes a working knowledge of networks

and information security, including the following topics:

+  Deploying and administering Deep Discovery or TippingPoint products

+  Using Oracle VM VirtualBox™ or VMware™ products

Terminology

TERMINOLOGY

DESCRIPTION

Open Virtual
Appliance (OVA)

A ready-to-use software package (operating system with
applications) that does not require additional configuration or
installation. Virtual Analyzer supports only image files in the Open
Virtual Appliance (OVA) format.

Sandbox image

A template used to deploy sandbox instances in Virtual Analyzer.
A sandbox image includes an operating system, installed
software, and other settings necessary for that specific computing
environment.

Sandbox instance

A single virtual machine based on a sandbox image.

Virtual Analyzer

A secure virtual environment that manages and analyzes objects
submitted by integrated products and administrators. During
analysis, Virtual Analyzer rates the characteristics in context and
then assigns a risk level to the object based on the accumulated
ratings.

Virtual Analyzer
Sensors

A collection of utilities that execute and detect malware, and
record all behavior in Virtual Analyzer.

Virtual Machine Disk
(* . vmdk)

A file format used in virtual machines like VMware Workstation or
Oracle VM VirtualBox.
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Chapter 2

OVA File Creation Using New Virtual
Machine Images

Learn how to create a Virtual Analyzer-supported OVA file in the following topics:

Downloading and Installing VirtualBox on page 2-6
Creating Virtual Machine Images on page 2-7
Modifying the Virtual Machine Environment on page 2-27

Reducing the Size of VirtualBox Disk Images on page 2-37

Exporting Virtual Machine Images to OVA Files on page 2-39
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Creating OVA Files Using New Virtual Machine
Images

Procedure
1. Prepare the operating system and required applications.
For details, see Required Software on page 2-2.
2. Download and install VirtualBox.
For details, see Downloading and Installing VirtualBox on page 2-6.
3.  Create a virtual machine image.
For details, see Creating VVirtual Machine Images on page 2-7.
4. Modify the environment of the virtual machine image.
For details, see Modifying the Virtual Machine Environment on page 2-27.
5. Reduce the size of the VirtualBox Disk Image.
For details, see Reducing the Size of VirtnalBox Disk Images on page 2-37.
6. Export the virtual machine image to an OVA file.

For details, see Exporting Virtual Machine Images to OVA Files on page 2-39.

Required Software

The following software must be installed on the virtual machine to achieve satisfactory

detection results.
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TABLE 2-1. Required Applications

SOFTWARE DESCRIPTION

Operating system | Virtual Analyzer supports the following operating systems:

Windows XP, Windows 7, Windows 8/8.1, Windows 10 Version 1909
and before, Windows Server 2003/2003 R2, Windows Server
2008/2008 R2, Windows Server 2012/2012 R2, Windows Server
2016, and Windows Server 2019.

O Important
<«

Package the installer as an I1SO file.

Activate Windows with a valid product key after the tool
has validated and modified virtual machine settings. Do
not activate Windows before that.

«  Use a computer name that reflects your organizations'
naming scheme.

Disable automatic updates.

- Trend Micro recommends using the English version of the
listed operating systems.
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SOFTWARE

DESCRIPTION

Office suite

Virtual Analyzer supports the following office suites:

Office 2003 (32-bit), Office 2007 (32-bit), Office 2010 (32-bit and 64-

bit), Office
Office 365

2013 (32-bit and 64-bit), Office 2016 (32-bit and 64-bit),
(32-bit and 64-bit), and Office 2019 (32-bit and 64-bit)

o
¥

ortant

For Office 2007 and above, Microsoft Word, Microsoft
Excel, Microsoft PowerPoint, and Microsoft Publisher
must be installed.

Activate Microsoft Office with a valid product key after the
tool has validated and modified virtual machine settings.
Do not activate Microsoft Office before that.

After installation, open all Microsoft Office applications
and verify that the main editing screen is displayed. If any
confirmation dialog or welcome screen displays, make
any selection to close the screen and display the main
editing screen.

Welceme te Microsoft Office 2010 =

Help Protect and Improve Microsoft Office =a.0Officé

© Tnstallimportant and recommended updates for Offce, Windows and other Mcrosaft software, Offer me nen optional Office and
Vicrosoft software, check online for solutions to problems, dovnload fles to help Microsoft diagnose system problems, automatically
update Office content, nd help improve Office.

o Use Recommended Settings

o Install Updates Only

© Tnstallimportant and recommended updates for Office, Windows and other Mcrosaft software, Offer me nen optional Office and
Microsoft software.

° Don't make changes

(© Choosing this option could expose your computer to security threats.

Get more information on how to tum these settings on and off

Same information might be sent to Microsaft. This information is not used to identify or cantact you.
Read our privacy siatement.

FIGURE 2-1. Help Protect and Improve Microsoft
Office

Verify that your license allows you to virtualize the
applications. For details, see https://support.office.com.

Disable automatic updates.

Enable macros. For details, see Enable or disable
macros in Office files



https://support.office.com
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
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SOFTWARE DESCRIPTION

Internet Explorer | Internet Explorer must be configured as the default web browser of
the operating system. For Windows 8.1 and before, the tool will
configure the setting. For Windows 10, the setting must be
configured manually before the tool is used to validate the image.

Adobe Reader Install the version of Adobe Reader that is most widely used in your
organization. To download the most current version of Adobe
Reader, go to http://www.adobe.com/downloads/.

If you do not install Adobe Reader, Virtual Analyzer:

« Installs Adobe Reader 8, 9, and 11 on all Windows XP and
Windows Server 2003/2003 R2 images during importing.

. Installs Adobe Reader 9, 11, and DC on all Windows 7 and
newer images during import.

«  Uses all versions during analysis.

WARNING!

This consumes additional computing resources.

Configure Adobe Reader to manually check for and install updates.
For details, see https://helpx.adobe.com/acrobat/kb/reader-acrobat-
updater-settings.html.

.NET Framework | Installs .NET Framework 3.5 or later if the operating system is
Windows XP or Windows Server 2003.

Note

Trend Micro recommends installing JRE8 on the virtual machine to achieve satisfactory
detection results.



http://www.adobe.com/downloads/
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
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Q 0} Q Important

. Do not install VMware tools to avoid triggering the anti-virtual machine functions of
some malware.

+ Do not install any anti-malware software on the virtual machine to ensure normal
operation of Virtual Analyzer.

Downloading and Installing VirtualBox

Procedure

1. Download the latest version of VirtualBox from https://www.virtualbox.org/wiki
Downloads.

Note

The VirtualBox Open Source Edition is licensed under the GPL V2. The full text of
the license is available at http://www.gnu.org/licenses/old-licenses/gpl-2.0.html.

2.  Configure the language settings using one of the following methods:

. Install VirtualBox with English as the default language.

«  After installation, go to File > Preferences > Language and then select
English.



https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
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{fi’ VirtualBox - Preferences ? ot
E General Language
@ Input Interface Languages
Default ~
@ Update English (built-in)
@ Bahasa Indonesia
Language Catals
@ Displ Cettina
Ispay Danzk
Iﬁ Metwork Deutich {Deutschland)
Esparicl
D Extensions Fuskara ~
Language: English (built-in)
Eﬁ Proxy Author(z): Orade Corporation

Cancel

FIGURE 2-2. Language Settings

Creating Virtual Machine Images

Procedure

1.  Open VirtualBox.
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The VirtualBox Manager window opens.

¥ Oracle UM VirtualBox Manager

File Machine Help

¢ AR Gap

Preferences  Import Export New Add

‘Welcome to VirtualBox!

The left part of application window contains global tools and
lists all virtual machines and virtual machine groups on your
computer. You can import, add and create new YMs using
corresponding toolbar buttons. You can popup a tools of
currently selected element using corresponding element
button.

You can press the FL key to getinstant help, or visit
www.virtualbox.org for more information and latest news.

FIGURE 2-3. VirtualBox Manager

2. Click New.
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The Create Virtual Machine window opens.

Create Virtual Machine

Name and operating system

Please choose a descriptive name and destination folder for the new virtual
machine and select the type of operating system you intend to install on it.
The name you choose will be used throughout VirtualBox to identify this

machine.
Mame: || |
Machine Folder: | D:\irtualBox YMs b |
. - L]
Type: |Microsoft Windows =4
Wio
Version: |Windows 10 (54-bit) w7
Expert Mode Mext Cancel

FIGURE 2-4. Create Virtual Machine
3.  On the Name and operating system screen, configure the following:
+  Name: Type a permanent name for the virtual machine.

. Type: Select Microsoft Windows.

. Version: Select Windows XP, Windows 2003, Windows 7, Windows 8,
Windows 8.1, Windows 10, Windows 2008/2008 R2, Windows 2012/2012
R2, Windows 2016, or Windows 2019.
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4. Click Next.

The Memory size screen appears.

“  Create Virtual Machine

Memory size

Select the amount of memory (RAM) in megabytes to be allocated to the
wirtual machine.

The recommended memory size is 2048 MEB,

0 24 [ e

4 MB 32768 MB

FIGURE 2-5. Memory Size
5.  Specify the recommended memory size for your operating system.
+  Windows XP and Windows Server 2003: 512 MB

. Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2, Windows Server 2016, and Windows Server 2019: 1024 MB

6. Click Next.
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The Hard disk screen appeats.

Create Virtual Machine

Hard disk

If you wish you can add a virtual hard disk to the new machine, You can
either create a new hard disk file or select one from the list or from another

|ocation using the folder icon.

If you need a more complex storage set-up you can skip this step and make
the changes to the machine settings once the machine is created.

The recommended size of the hard disk is 50,00 GB.

) Do not add a virtual hard disk
(® Create a virtual hard disk now
() Use an existing virtual hard disk file

Empty

FIGURE 2-6. Hard Disk

7. Select Create a virtual hard disk now and then click Create.
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The Hard disk file type screen appears.

Create Virtual Hard Disk

Hard disk file type

Please choose the type of file that you would like to use for the new virtual
hard disk. If you do not need to use it with other virtualization software you
can leave this setting unchanged.

() DI (VirtualBox Disk Image)
() WHD {virtual Hard Digk)
(® VMDK (virtual Machine Disk)

Expert Mode Cancel

FIGURE 2-7. Hard Disk File Type

8.  Select VDI (VirtualBox Disk Image) or VMDK (Virtual Machine Disk) and
then click Next.




OVA File Creation Using New Virtual Machine Images

The Storage on physical hard disk screen appears.

€ Create Virtual Hard Disk

Storage on physical hard disk

Please choose whether the new virtual hard disk file should grow as it is used
{dyrnamically allocated) or if it should be created at its maximum size (fixed
size).

A dynamically allocated hard disk file will only use space on your physical
hard disk as it fills up {up to a maximum fixed size), although it will not shrink
again automatically when space on it is freed.

& ficed size hard disk file may take longer to create on some systems but is
often faster to use,

You can also choose to split the hard disk file into several files of up to two
gigabytes each. This is mainly useful if vou wish to store the virtual machine an
removable USE devices or old systems, some of which cannot handle very large
files.

(® Dynamically allocated
() Fixed size
] split into files of less than 2GE

FIGURE 2-8. Storage on Physical Hard Disk

9.  Sclect Dynamically allocated and then click Next.

O Important
\ ¢

Do not select Fixed size or Split into files of less than 2GB.
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The File location and size screen appears.

% Create Virtual Hard Disk

File location and size

Flease type the name of the new virtual hard disk file into the box below or didk
on the folder icon to select a different folder to create the file in.

Fhang\VirtualBox VMs\win 10_office2019_x64\win10_office2019_x&4.vmdk | [

Select the size of the virtual hard disk in megabytes. This size is the limit on the
amount of file data that a virtual machine will be able to store on the hard disk.

y

4.00 MB 2.00TE

FIGURE 2-9. File Location and Size
10. (Optional) Click the folder icon to change the path of the virtual disk file.

11.  Specify the virtual disk size for your operating system.

. Windows XP and Windows Server 2003: 15 GB
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. Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2, Windows Setrver 2016, and Windows Server 2019: 35 GB

Note

Trend Micro recommends specifying a larger virtual disk size if you intend to install
additional software.

12. Click Create.

VirtualBox creates the virtual machine. The new virtual machine appears in the left
pane of the VirtualBox Manager screen.

W Oracle UM VirtualBox Manager - m} X

File Machine Help

55 e TR

New Settings Discard  Start

[=] General [=] Preview

0 @ Powered Off Mame: win10_office2016_x64
Operating System:  Windows 10 (64-bit)
Settings File Location:  D:\VirtualBox VMs
\win10_office2016_x64

[&] system win10_office2016_x64

Base Memory: 1024 MB

BootCrder:  Floppy, Optical, Hard Disk

Acceleration:  VT-x/AMD-V, Nested Paging, Hyper-V
Paravirtualization

[®] pisplay

Video Memory: 123MB
Graphics Controller: VBOXSVGA
Remote Desktop Server:  Disabled
Recording: Disabled

Storage

Contraller: SATA
SATAPortQ:  winl0_office2016_x64.vmdk (Normal, 25,00 GB)
SATAPort1:  [Optical Drive] Empty

fn Audio

HostDriver:  Windows DirectSound
Contraller:  Intel HD Audia

EP Network
Adapter 1: - Intel PRO/1000 MT Desktop (NAT)

[ use

USB Controller:  OHCE
Device Filters: 0 (0 active)

[ shared folders
MNone
&) Description

MNane

FIGURE 2-10. Newly-created Virtual Machine

Ensure that the virtual machine is not in any group.

13. Click Settings.
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The Settings window opens.

Shared Folders

) win10_office2016_x64 - Settings ? X

E General General

IEI System Basic Advanced Description Disk Encryption

B Display Mame: |win10_office2016_x64 |

Storage Type: | Microsoft Windows -
Version: | Windows 10 (64-bit) -

(D: Audio

@ Metwork

@ Serial Ports

ﬁ USE

(-

£

User Interface

Cancel

FIGURE 2-11. VirtualBox Settings

14. In the left pane, click System.
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The System screen appears.

23 win10_office2016_x64 - Settings ? X
E General System
@ System Motherboard Processor Acceleration
|§| Display Base Memary: '
4MB 327538 MB
Storage
o]
. Boot Order: Floppy
(‘D:l Audio [©) Optical
Hard Disk
Iﬁ Network [l @ MNetwork
@ Serial Ports Chipset: | ICH9 hd
ﬁ} USB Pointing Device: |USB Tablet -
Ij Extended Features: Enable If0 APIC
Shared Fold
ared rolders [ Enable EFI (special OSes only)
EI User Interface [ Hardware Clock in UTC Time

Cance

FIGURE 2-12. System Screen
15. On the Motherboard tab, configure the following:
«  Chipset: Select ICH9
. Pointing Device: Select USB Tablet
. Extended Features:

. Select Enable I/0O APIC

. (Optional) Select Enable EFI (special OSes only) if you want to create
an EFI-compatible image. EFI-compatible images are only supported by
the following products: Deep Discovery Inspector 5.6 and later, Deep
Discovery Email Inspector 3.6 and later, Deep Discovery Analyzer 6.8
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and later, Deep Discovery Director 5.1 and later, Deep Discovery Web
Inspector 2.5 and later

16. Go to the Processor tab and then select Enable PAE/NX.

17. Go to the Acceleration tab and then select Enable Nested Paging. If you are
using VirtualBox 5.2 and before, select Enable VT-x/AMD-V as well.

ﬁ Note
*  The Acceleration tab is only available if the processor of the host system

supports virtualization technology and the virtualization setting is enabled in the
BIOS of the host system.

. VirtualBox 6.0 and later automatically enables VI-x/AMD-V if the processor of
the host system supports virtualization technology and the virtualization setting
is enabled in the BIOS of the host system.

18. In the left pane, click Storage.
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The Storage screen appears.

) win10_office2016_x64 - Settings ? X
E General Storage
IEI System Storage Devices Attributes
. ontroller - ; Name: |SATA |
B Display :
] wini0_office2016_xa4.vmdk Type: |AHCI hd
Homge @ Empty Port Count: |}‘_ = |
(D:I Audic [ use Host 1j0 Cache
@ Metwork
@ Serial Ports
ﬁ USB
D Shared Folders
EI User Interface
e g
Cancel

FIGURE 2-13. Storage Screen

19. If Controller: SATA appears under Storage Tree, remove the SATA controller
and then add an IDE controller.

a.  Click Controller: SATA and then click @ to remove the default controller.

b.  Click ¢ and then select PIIX4 (Default IDE).
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@ win10_office2016_x64 - Settings

E General Storage

System Storage Devices

Information

Display
Storage
Audio
MNetwork
Serial Ports
Use

Shared Folders

OO aTE N E

User Interface

The Storage Tree can contain several controllers of
different types. This machine currently has no
controllers,

AHCI (SATA)

PllX4 (Default IDE)

SPREOOOHOOOD

&

PIIX3 (IDE)

ICHE (IDE)

LsiLogic (Default SCSI)
Buslogic (5CSI)
182078 (Floppy)
LsiLogic SAS (SAS)
Use

NVMe (PCle)

virtio-scsi

Cancel

FIGURE 2-14. Add Storage Controller

c.  Click Controller: PIIX4 and then click E
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The following window appears:

win10_office2016_x64 - Hard Disk Selector ? e
Medium

Add Create  Refresh

Mame Virtual Size Actual Size

v Attached

win10_office2016_x64.vmdk 25.00 GB 3.19 MB
Not Attached

Search By Name ¥ |@ Cb

FIGURE 2-15. Hard Disk Selector

Select the virtual hard disk file that you previously created and then click
Choose.

Under Attributes, verify that Hard Disk is IDE Primary Master.
Under Storage Tree, click Controller: IDE and then click (g} .

In the Optical Disk Selector window, click Leave Empty.

Under Attributes, verify that CD/DVD Drive is IDE Secondary Master.
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€23 win10_office2016_x64 - Settings ? ®
E General Storage
IE‘ System Storage Devices Attributes
|E| Disal @ Controller: IDE Optical Drive: | IDE Secondary Master hd @l
Isplay
win10_office2016_x64.vmdk [ Live co/ovD

Storage @ Empty Information

Type: —
(D] Audio b

Size: —
@ Network Location: —

Attached to: —

@ Serial Ports
ﬁ USB
Ij Shared Folders
EI User Interface

@@=

Cnc

FIGURE 2-16. IDE Secondary Master

20. Under Attributes, click (=), and then select Choose a virtual CD/DVD disk
file....

21.  Select the ISO file containing the operating system installer.

The ISO file is available as a device.

22. (Optional) In the left pane, click Audio and verify that Enable Audio is enabled.
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23 win10_office2016_x64 - Settings ? X
E General Audio

E‘ System Enable Audio

|§| . Host Audio Driver: | Windows DirectSound A

Display
Audio Controller: | Intel HD Audio A
Storage
Extended Features: Enable Audio Output

(D:I Audio [ Enable Audio Input

@ Metwork

@ Serial Ports

ﬁ USB

D Shared Folders

EI User Interface

Cancel

FIGURE 2-17. Audio Options Settings
23. In the left pane, click USB and then select Enable USB Controller.

Important

Verify that USB 1.1 (OHCI) Controller is selected.
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23 win10_office2016_x64 - Settings ? X
E General uUsB
E‘ System Enable USE Controller
) (@ USB 1.1 (OHCI) Controller
|§| Display
(C) USB 2.0 (EHCI) Controller
Storage (0) USB 3.0 (xHCI) Controller
. ice Filters
(D:I Audio USE Device Fi
@ Metwork @
@ Serial Ports
ﬁ Use
D Shared Folders
EI User Interface
Cancel

FIGURE 2-18. Enable USB Controller

24. In the left pane, click Shared Folders and then verify that no folders are shared.
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Shared Folders

£ win10_office2016_x64 - Settings ? X
g

E General Shared Folders

li‘ System Shared Folders

i Mame Path Access Auto Mount At [a

|§| Display )
Machine Folders

Storage

(DJ Audio

@ Metwork

@ Serial Ports

ﬁ USB

User Interface

Cancel

FIGURE 2-19. Shared Folders Settings
25. Click OK.

The Settings window closes.

26. On the VirtualBox Manager screen, click g to power on the image.
Start
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¥ Oracle UM VirtualBox Manager - m} x

File Machine Help

B e g8 o

New  Settings

= T =] General =) preview

0 @ Powered 0 Mame: win10_office2016_x64
Operating System: ~ Windows 10 (54-bit)
Settings File Location: ~ D:\Virtualbax ¥Ms
\Win10_office2015_x64

[ system win10_office2016_x64

Base Memory: 1024 MB

Boot Order:  Floppy, Optical, Hard Disk

Chipset Type:  ICH

Acceleration:  VT-x/AMD-V, Nested Paging, PAE/NX,
Hyper-¥ Paravirtuaization

[®) pisplay

video Memary: 128 MB
Graphics Controller: VBoxSVGA
Remote Desktop Server:  Disabled
Recording: Disabled

Storage
Controller: IDE

IDE Primary Master: win10_office2016_x64.vmdk (Normal, 25.00 GE)
IDE Secondary Master:  [Optical Drive] Empty
fp Audio

HostDriver:  Windows Directsound
Controller:  Intel HD Audio

EP Network
Adapter 1:  Intel PRO/1000 MT Desktop (NAT)

[ usB

USB Controller:  OHCI
Device Filters: 0 (0 active)

[ Shared folders
Mone
&) Description

None

FIGURE 2-20. VirtualBox Manager

The installation process starts.

27. Follow the on-screen instructions to install the guest operating system.
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+4 Windows Setup

&R Windows’

stall:[English (United States) -
i English (United States) -
Enter your language and other preferences and click "Next" to contint

I ights reserved.

FIGURE 2-21. Operating System Installation Process

28. Install Microsoft Office and other software to achieve satisfactory detection results.

Modifying the Virtual Machine Environment

Modify the virtual machine environment to run Virtual Analyzer Sensors, a collection of
utilities that execute and detect malware, and record all behavior in Virtual Analyzer.

Modifying the Virtual Machine Environment (Windows XP and Windows Server 2003) on
page 2-28

Modifying the Virtual Machine Environment (Windows 7/8/8.1/10, Windows Server
2008/2008 R2, Windows Server 2012/2012 R2, Windows Server 2016, and Windows
Server 2019) on page 2-30
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Modifying the Virtual Machine Environment (Windows XP
and Windows Server 2003)

Procedure

1.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2.  Perform the following tasks:

TASK STEPS

Set the "Administrator" Type net user "Administrator" 1111.
logon password to "1111".

Configure automatic logon | a. Type the following commands:
from the “Administrator”

account. . REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£
The logon prompt is
bypassed and the
“Administrator”

REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t

account is REG SZ /d 1111 /f

automatically used -

to log on to the + REG ADD "HKEY LOCAL MACHINE\SOFTWARE
system every time \Microsoft\Windows NT\CurrentVersion
the virtual machine \Winlogon" /v AutoAdminLogon /t
starts. REG_SZ /d 1 /f

b. Restart the image.
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TASK STEPS

ﬁ Note

No logon prompt is displayed and the
“Administrator” account is automatically used to
log on.

j’ Administrator

8 Internet .__\) My Documents
Internet Explorer b
. 5 My Recent Documents
( E-nw
1| i

ail
icrosoft OFfice Outlook, _f\/ My Fictures

\’ MSh ___'/ My Music
:3! My Computer
e Windows Media Player

& Contral Panel
,,3 Windows Messenger

@ Set Program Access and
§ Defaults

Microsoft OFfice Excel 2003 .
. |- Printers and Faxes
'® Tour Windows P @) Help and Support
b | Files and Settings Transfer I') Search
Wizard
=) Run...

All Programs D

ﬁ| Log OFF @D | Turn OFf Computer

74 start

FIGURE 2-22. Windows XP Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.
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TASK STEPS

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.

all installed network . . .
The configuration of all installed network adapters

adapters . - )
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network Type netsh interface ip set address

adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall. | Type netsh firewall set opmode mode=DISABLE.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

3. Restart the virtual machine.

Modifying the Virtual Machine Environment (Windows
7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2, Windows Server 2016, and Windows Server
2019)

Procedure

1.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2.  Perform the following tasks:
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TASK

STEPS

Enable the “Administrator”
account

Type net user “Administrator” /active:yes.

Set the logon password
for the “Administrator”
account to “1111”

Type net user "Administrator" 1111.

Configure automatic logon
from the administrator
account

ﬁ Note

Each time the
image starts, the
logon prompt is
bypassed and the
“Administrator”
account is
automatically used
to log on to the
system.

a. Type the following commands:

. REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
REG_SZ /d Administrator /f

d REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG Sz /d 1111 /£

. REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v AutoAdminLogon /t
REG_SZ /d 1 /f
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TASK STEPS

ﬁ Note

In Windows Server 2008/2008 R2,
Windows Server 2012/2012 R2,
Windows Server 2016, and Windows
Server 2019, launch the Local
Security Policy snap-in (secpol.msc)
to disable the Password must meet
complexity requirements Local
Security Setting.

Local Securty Policy [=To

FIGURE 2-23. Disable Password
must meet complexity requirements

+  Restart the image.
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TASK STEPS

No logon prompt is displayed and the
“Administrator” account is automatically used
to log on.

i 2
—
1' Getting Started

q Connect to a Projector
&E) Remote Desktop Connection

Sticky Notes

6& Snipping Tool

| Calculator

_.f_,[ Paint
..“ XPS Viewer

evices and Printers

& Windows Faxand Scan
"“5’1 Default Programs

@ Micrasoft Office Waord 2003 e

¥ All Programs

Bl . ©

FIGURE 2-24. Windows 7 Administrator

Account
View all user accounts Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.
all installed network
adapters
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TASK

STEPS

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network
adapter to use DHCP

Type netsh interface ip set address
name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall

Type netsh advfirewall set allprofiles state
off.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

(Optional) Install Adobe
Flash in Windows Server
2016 and Windows
Server 2019

Type c:\> dism /online /add-package /
packagepath:”C: \Windows\servicing\Packages
\Adobe-Flash-For-Windows-
Package~31bf3856ad364e35~amd64~~10.0.14393.0.

mum”’

3.  Perform the following tasks using the Windows graphical user interface:
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TASK

STEPS

Configure AutoPlay

Open the Windows Start menu, type Control
Panel into the search box and press ENTER.

In the Control Panel, go to Hardware and Sound
> AutoPlay.

FIGURE 2-25. AutoPlay

For Software and games, select Install or run
program from your media.

Click Save.
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TASK

STEPS

Configure default web
browser on Windows 10

Internet Explorer should come pre-installed on
Windows 10. To configure Internet Explorer as the
default web browser, perform the following:

a. Open the Windows Start menu, type befault
apps and press ENTER.

b. Under Web browser, select the current web

browser.
Settings - o
@ Home Default apps
©°
Apps
L Photo viewer
1= Apps & features
E Photos
| &5 Defauit apps
@ Offline maps Video player
[ Apps for websites B Movies & TV
oH Video playback
Web browser
& Startup

E Microsoft Edge

Reset to the Microsoft recommended defaults

Reset

FIGURE 2-26. Default apps

c. Inthe Choose an app context menu, select
Internet Explorer.

d. If the Before you switch dialog appears, select
Switch anyway.
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TAsSK STEPS
(Optional) Change the Trend Micro recommends settings the screen
display resolution resolution to at least 1152 x 864 to avoid triggering

the anti-virtual machine functions of some malware.

a. Open the Windows Start menu, type bisplay
settings and press ENTER.

b. Under Resolution, select 1152 x 864 or any
higher resolution.

c. Inthe prompt that appears, click Keep changes.

4. Restart the virtual machine.

Reducing the Size of VirtualBox Disk Images

Procedure
1. Uninstall unnecessary applications and optional Windows components.
2. Run Disk Cleanup to free up space on the hard disk.
The utility searches for files and data that you can safely delete, including:
+  Temporary Windows and Internet files
. ActiveX controls, Java applets, and other downloaded program files
+  Files in the Recycle Bin

For details, see the Microsoft Help: http://windows.microsoft.com/en-us
windows/delete-files-using-disk-cleanup#delete-files-using-disk-
cleanup=windows-7.

3.  Use Deployment Image Servicing and Management (DISM) to free up space
on the hard disk.

DISM is a command-line utility that can be used to free up disk space by managing
the Windows Component Store (WinSxS directory).



http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
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For details, see the Microsoft Developer resource website: https://
msdn.microsoft.com/en-us/windows/hardware/commercialize /manufacture/

desktop/clean-up-the-winsxs-folder

a.  Open a Command Prompt window.

ﬁ’ Note

Depending on the Windows version, not all of the following commands may be
supported.

b. Typedism /Online /Cleanup-Image /SPSuperseded.

c. Typedism /Online /Cleanup-Image /StartComponentCleanup /
ResetBase.

4.  Download SDelete and then zero out the free space on the hard disk.

SDelete is a free command-line utility that securely deletes existing files and
permanently erases file data in unallocated clusters of a disk. The utility can also
ensures that even encrypted files cannot be recovered by overwriting all addressable
locations with new and random characters.

a.  Download sdelete. zip from the Windows Sysinternals website: https://
technet.microsoft.com/en-us/sysinternals/sdelete.aspx

b.  Extract sdelete.exe.
c.  Open a Command Prompt window.
d.  Go to the folder that contains sdelete.exe.
e. 'Type sdelete -z [drive letter].
SDelete zeroes the free space on the hard disk.
5.  Shut down the virtual machine.
6. Open a Command Prompt window on the host system.

7. Type "C:\Program Files\Oracle\VirtualBox\VBoxManage.exe"

modifyhd [path\[vm name.vdi] --compact.



https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://technet.microsoft.com/en-us/sysinternals/sdelete.aspx
https://technet.microsoft.com/en-us/sysinternals/sdelete.aspx
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The virtual hard disk drive size is reduced.

Exporting Virtual Machine Images to OVA Files

A virtual machine image comprises many uncompressed files. The files must be
combined into a single OVA file to avoid issues when importing;

Important

Verify that the size of the created OVA file is supported by your product.

For details, go to https://docs.trendmicro.com/en-us/home.aspx#Enterprise.

Procedure

1. On the VirtualBox Manager screen, power off the virtual machine.

Note
Vetify that the CD/DVD dtive is empty before poweting off and exporting,

2.  Go to File > Export Appliance.



https://docs.trendmicro.com/en-us/home.aspx#Enterprise
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The Export Virtual Appliance window appears.

Export Virtual Appliance

Virtual machines to export

Please select the virtual machines that should be added to the appliance. You can select more than one. Please note that these machines have to be turned
off before they can be exported.

win10_office2016_xBd

Expert Mode Cancel

FIGURE 2-27. Export Virtual Appliance

3. Select the virtual machine image to export and click Next.
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The Appliance settings screen appears.

€ Export Virtual Appliance

Appliance settings

Please choose a format to export the virtual appliance to.

The Open Virtualization Format supparts only ovf or ova extensions. If you use the ovf extension, several files will be written separately. If you use
the ova extension, all the files will be combined into one Open Virtualization Format archive,

The Oracle Cloud Infrastructure format supports exporting to remote coud servers only. Main virtual disk of each selected machine will be uploaded to
remote server,

Format: | Open Virtualization Format 1.0 -

Please choose a filename to export the virtual appliance to, Besides that you can specify a certain amount of options which affects the size and content of
resulting archive.

File: |C: Wsers\administrator \Documents\win 10_office2016_x&4.0va | Ea

MAC Address Policy: |Indude only NAT network adapter MAC addresses -
Additionally: [] Write Manifest fle
[ indude 150 image files

FIGURE 2-28. Appliance settings

4.  Configure the following:

«  File: Accept the default name and path or click :Ld to select a different file.

. Format: Select OVF 1.0.

Important

Format options include OVF 0.9, 1.0 and 2.0. Virtual Analyzer does not
support OVF 2.0.

+  MAC Address Policy: Sclect Include only NAT network adapter MAC
addresses.
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5. Click Next.

The Virtual system settings screen appears.

< Export Virtual Appliance

Virtual system settings

This is the descriptive information which will be added to the virtual appliance. You can change it by double dicking on individual lines.

Wirtual System 1
€2 Name win10_office2016_x64
@ Product
& Product-URL
@ Vendor
&) Vendor-URL
@ Version
@ Description
@ License

Restore Defaults Export Cancel

FIGURE 2-29. Virtual system settings

6.  Verify that the License field is empty and then click Export.
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VirtualBox creates the OVA file.

Iﬁ Exporting Appliance ...: Export appliance 'ChUsers] Docume...

Exporting to disk image 'win10_office2016_x&64-disk001.vmdk' ... (2/3)

B 8% X

10 minutes remaining

FIGURE 2-30. Disk Image Export Progress Bar
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Chapter 3

OVA File Creation Using Converted
Virtual Hard Disk Drives

Learn how to prepare and import an OVA file in the following topics:

Modifying the Virtual Machine Environment on page 3-6

Exporting Virtual Machine Images on page 3-18

Converting V"Mware ESXi Virtual Hard Disk Drives on page 3-25

Creating Virtual Machine Images Using Converted 1 irtnal Hard Disk Drives on page 3-32
Confignring Virtual Machine Inmages on page 3-49

Exporting Virtual Machine Images to OVA Files on page 3-54
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Creating OVA Files Using Converted Virtual
Hard Disk Drives

Procedure
1.  Prepare Adobe Reader.
For details, see Preparing Adobe Reader on page 3-6
2.  Modify the environment of the virtual machine image.
For details, see Modifying the Virtual Machine Environment on page 3-6.
3. Export the virtual machine image.
For details, see Exporting VVirtnual Machine Images on page 3-18.
4.  Convert the virtual hard disk drive of the exported image to the VirtualBox format.
For details, see Converting V" Mware ESXi Virtual Hard Disk Drives on page 3-25.
5.  Create a new virtual machine image using the converted virtual hard disk drive.

For details, see Creating VVirtual Machine Images Using Converted 1V irtnal Hard Disk
Drives on page 3-32.

6. Configure the new virtual machine image.
For details, see Configuring Virtual Machine Images on page 3-49.
7.  Export the virtual machine image to an OVA file.

For details, see Exporting Virtnal Machine Images to OVA Files on page 3-54.

Required Software

The following software must be installed on the virtual machine to achieve satisfactory

detection results.
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TABLE 3-1. Required Applications

SOFTWARE DESCRIPTION

Operating system | Virtual Analyzer supports the following operating systems:

Windows XP, Windows 7, Windows 8/8.1, Windows 10 Version 1909
and before, Windows Server 2003/2003 R2, Windows Server
2008/2008 R2, Windows Server 2012/2012 R2, Windows Server
2016, and Windows Server 2019.

O Important
<«

Package the installer as an I1SO file.

Activate Windows with a valid product key after the tool
has validated and modified virtual machine settings. Do
not activate Windows before that.

«  Use a computer name that reflects your organizations'
naming scheme.

Disable automatic updates.

- Trend Micro recommends using the English version of the
listed operating systems.
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SOFTWARE

DESCRIPTION

Office suite

Virtual Analyzer supports the following office suites:

Office 2003 (32-bit), Office 2007 (32-bit), Office 2010 (32-bit and 64-

bit), Office
Office 365

2013 (32-bit and 64-bit), Office 2016 (32-bit and 64-bit),
(32-bit and 64-bit), and Office 2019 (32-bit and 64-bit)

o
¥

ortant

For Office 2007 and above, Microsoft Word, Microsoft
Excel, Microsoft PowerPoint, and Microsoft Publisher
must be installed.

Activate Microsoft Office with a valid product key after the
tool has validated and modified virtual machine settings.
Do not activate Microsoft Office before that.

After installation, open all Microsoft Office applications
and verify that the main editing screen is displayed. If any
confirmation dialog or welcome screen displays, make
any selection to close the screen and display the main
editing screen.

Welceme te Microsoft Office 2010 =

Help Protect and Improve Microsoft Office =a.0Officé

© Tnstallimportant and recommended updates for Offce, Windows and other Mcrosaft software, Offer me nen optional Office and
Vicrosoft software, check online for solutions to problems, dovnload fles to help Microsoft diagnose system problems, automatically
update Office content, nd help improve Office.

o Use Recommended Settings

o Install Updates Only

© Tnstallimportant and recommended updates for Office, Windows and other Mcrosaft software, Offer me nen optional Office and
Microsoft software.

° Don't make changes

(© Choosing this option could expose your computer to security threats.

Get more information on how to tum these settings on and off

Same information might be sent to Microsaft. This information is not used to identify or cantact you.
Read our privacy siatement.

FIGURE 3-1. Help Protect and Improve Microsoft
Office

Verify that your license allows you to virtualize the
applications. For details, see https://support.office.com.

Disable automatic updates.

Enable macros. For details, see Enable or disable
macros in Office files



https://support.office.com
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
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SOFTWARE DESCRIPTION

Internet Explorer | Internet Explorer must be configured as the default web browser of
the operating system. For Windows 8.1 and before, the tool will
configure the setting. For Windows 10, the setting must be
configured manually before the tool is used to validate the image.

Adobe Reader Install the version of Adobe Reader that is most widely used in your
organization. To download the most current version of Adobe
Reader, go to http://www.adobe.com/downloads/.

If you do not install Adobe Reader, Virtual Analyzer:

« Installs Adobe Reader 8, 9, and 11 on all Windows XP and
Windows Server 2003/2003 R2 images during importing.

. Installs Adobe Reader 9, 11, and DC on all Windows 7 and
newer images during import.

«  Uses all versions during analysis.

WARNING!

This consumes additional computing resources.

Configure Adobe Reader to manually check for and install updates.
For details, see https://helpx.adobe.com/acrobat/kb/reader-acrobat-
updater-settings.html.

.NET Framework | Installs .NET Framework 3.5 or later if the operating system is
Windows XP or Windows Server 2003.

Note

Trend Micro recommends installing JRE8 on the virtual machine to achieve satisfactory
detection results.



http://www.adobe.com/downloads/
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
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Q 0} Q Important

. Do not install VMware tools to avoid triggering the anti-virtual machine functions of
some malware.

Do not install any anti-malware software on the virtual machine to ensure normal
operation of Virtual Analyzer.

Preparing Adobe Reader

Perform the following steps if Adobe Reader is installed on the virtual machine.

Procedure
1. Disable automatic updates.

For details, see http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-
acrobat-reader.html.

2. Install the necessary Adobe Reader language packs so that Virtual Analyzer can

process files authored in languages other than those supported in your native
Adobe Reader.

For example, if you use the English version of Adobe Reader and you expect to
analyze files authored in East Asian languages, install the Asian and Extended
Language Pack.

3. Start Adobe Reader.

Important

Perform this step before exporting the virtual machine.

Modifying the Virtual Machine Environment

Modify the virtual machine environment to run Virtual Analyzer Sensors, a collection of
utilities that execute and detect malware, and record all behavior in Virtual Analyzer.



http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-acrobat-reader.html
http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-acrobat-reader.html
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« Modifying the Virtual Machine Environment (Windows XP and Windows Server 2003) on
page 3-7

s Modifying the Virtual Machine Environment (Windows 7/8/8.1/10, Windows Server
2008/2008 R2, Windows Server 2012/2012 R2, Windows Server 2016, and Windows
Server 2019) on page 3-9

. Uninstalling V"Mware Tools on page 3-16

Modifying the Virtual Machine Environment (Windows XP
and Windows Server 2003)

Procedure

1. Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2.  Perform the following tasks:

TASK STEPS

Set the "Administrator” Type net user "Administrator" 1111.
logon password to "1111".

Configure automatic logon | a. Type the following commands:

from the “Administrator”
account + REG ADD "HKEY LOCAL MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t

ﬁ Note REG_SZ /d Administrator /f
The logon prompt is + REG ADD "HKEY LOCAL MACHINE\SOFTWARE
Pypas_sgd and,’the \Microsoft\wi;dows ET\CurrentVersion
Admlnls'trator \Winlogon" /v DefaultPassword /t
account is REG SZ /d 1111 /£
automatically used -
to log on to the + REG ADD "HKEY LOCAL MACHINE\SOFTWARE
system every time \Microsoft\Windows NT\CurrentVersion
the virtual machine \Winlogon" /v AutoAdminLogon /t
starts. REG_SZ /d 1 /f

b. Restart the image.
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TASK STEPS

ﬁ Note

No logon prompt is displayed and the
“Administrator” account is automatically used to
log on.

j’ Administrator

8 Internet .__\) My Documents
Internet Explorer b
. 5 My Recent Documents
( E-mail
Al Microsoft OFfice Outlook,

_f} My Pictures

\’ MSh ___'/ My Music
:3! My Computer
e Windows Media Player

& Contral Panel
,,3 Windows Messenger

@ Set Program Access and
§ Defaults

Microsoft OFfice Excel 2003 .
. |- Printers and Faxes
'® Tour Windows P @) Help and Support
b | Files and Settings Transfer I') Search
Wizard
=) Run...

All Programs D

ﬁ| Log OFF @D | Turn OFf Computer

74 start

FIGURE 3-2. Windows XP Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.
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TASK STEPS

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.
all installed network

The configuration of all installed network adapters

adapters ! c )
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network Type netsh interface ip set address

adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall. | Type netsh firewall set opmode mode=DISABLE.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

Uninstall VMware Tools. For details, see Uninstalling VMware Tools on page
3-16.

3. Restart the virtual machine.

Modifying the Virtual Machine Environment (Windows
7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2, Windows Server 2016, and Windows Server
2019)

Procedure

1.  Open a Command Prompt window (cmd . exe) using an account with
administrator privileges.

2.  Perform the following tasks:
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TASK STEPS

Enable the “Administrator” | Type net user “Administrator” /active:yes.
account.

Set the logon password Type net user "Administrator" 1111.
for the “Administrator”
account to “1111”.

Configure automatic logon | a. Type the following commands:

from the administrator
account. * REG ADD "HKEY_ LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /f

Each time the
image starts, the
logon prompt is
bypassed and the
“Administrator”
account is * REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE
automatically used \Microsoft\Windows NT\CurrentVersion
to log on to the \Winlogon" /v AutoAdminLogon /t
system. REG Sz /d 1 /£

d REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG Sz /d 1111 /£
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TASK STEPS

ﬁ Note

In Windows Server 2008/2008 R2,
Windows Server 2012/2012 R2,
Windows Server 2016, and Windows
Server 2019, launch the Local
Security Policy snap-in (secpol.msc)
to disable the Password must meet
complexity requirements Local
Security Setting.

Local Securty Policy [=To

FIGURE 3-3. Disable Password must
meet complexity requirements

+  Restart the image.
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TASK STEPS

No logon prompt is displayed and the
“Administrator” account is automatically used
to log on.

i 2
—
]I Getting Started »

u Connect to a Projector
%) Remote Desktop Connection

Sticky Notes

6& Snipping Tool

Calculatar

.‘;[ Paint

il XPSViewer

& Windows Faxand Scan
"‘"5’1 RS Default Programs

@ Micrasoft Office Word 2003 Help and Support

¥ All Programs

el
e - ©

FIGURE 3-4. Windows 7 Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.
all installed network
adapters




OVA File Creation Using Converted Virtual Hard Disk Drives

TASK STEPS

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is

Yes.
Configure a network Type netsh interface ip set address
adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall. | Type netsh advfirewall set allprofiles state
off.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

(Optional) Install Adobe Type c:\> dism /online /add-package /
Flash in Windows Server | packagepath:”C:\Windows\servicing\Packages

2016 and Windows \Adobe-Flash-For-Windows-
Server 2019 Package~31b£3856ad364e35~amd64~~10.0.14393.0.
mum”’

3. Perform the following tasks using the Windows graphical user interface:
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TASK STEPS
Configure AutoPlay a. Open the Windows Start menu, type Control

Panel into the search box and press ENTER.

b. Inthe Control Panel, go to Hardware and Sound
> AutoPlay.

|
((((((

FIGURE 3-5. AutoPlay

c. For Software and games, select Install or run
program from your media.

d. Click Save.
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TASK STEPS

Configure default web Internet Explorer should come pre-installed on
browser on Windows 10 Windows 10. To configure Internet Explorer as the
default web browser, perform the following:

a. Open the Windows Start menu, type befault
apps and press ENTER.

b. Under Web browser, select the current web
browser.

Settings. - o x

@ Home Default apps

Find a setting » Groove Music

L Photo viewer
1= Apps & features

E Photos
| &5 Defauit apps

M Offline maps Video player

@ Apps for websites B Movies & TV

oH Video playback

Web browser

E Microsoft Edge

Reset to the Microsoft recommended defaults

& Startup

Reset

FIGURE 3-6. Default apps

c. Inthe Choose an app context menu, select
Internet Explorer.

d. If the Before you switch dialog appears, select
Switch anyway.
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TASK

STEPS

(Optional) Change the
display resolution

Trend Micro recommends settings the screen
resolution to at least 1152 x 864 to avoid triggering
the anti-virtual machine functions of some malware.

a. Open the Windows Start menu, type bisplay
settings and press ENTER.

b. Under Resolution, select 1152 x 864 or any
higher resolution.

c. Inthe prompt that appears, click Keep changes.

Uninstall VMware Tools.

For details, see Uninstalling VMware Tools on page
3-16.

4. Restart the virtual machine.

Uninstalling VMware Tools

VMware Tools will attempt to connect to a VMware ESXi host, which might prevent

VirtualBox from importing the virtual machine image.

Procedure

1.  Go to Start > Control Panel.

The Control Panel screen appears.

2.  Check the list of installed programs.

+  Windows XP and Windows Server 2003: Click Add or Remove Programs.

+  Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2, Windows Server 2016, and Windows Server 2019: Click
Programs and Features.
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A list of installed programs appears.

® Add or Remove Programs E| @WZ'

—
Eﬁ-_‘f Currently installed programs: O show updakes Sort by: | Mame v
Mﬁ & | 15 Micrascft NET Framewerk 2.0 Service Pack 1 Size  185.00MB
Prografns §5) Microsoft .NET Framework 3.0 Service Pack 1 Size  245.00M8
% §8) Microscit JNET Framework 3.5 Size  Z5.02MB
ndd'uew C13 Microsoft Office Enterprise 2007 Size  BOB.00MB
Programs £13 Microsoft Office Professional Edtion 2003 Size  349.00MB
g §5) Microsoft isual C-4 2008 Redistributable - x86 9.0.30729.4148 Size  10.19M8
m ¥iware Tools
A [Remove
Windows oL
Components
To change this progranm of remoye it from y COMpLULEr, Change or Remove.
@’ 8 Windowes Irernet Explorer 8 Size 4.36MB
Set Program
Access and
Def aults

FIGURE 3-7. Add or Remove Programs (Windows XP)
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@uvlr; ¢ Ceontrel Panel » Programs » Programs and Features v | ¥y [ search ograms and Features F=)

Conitrol Panel Home . I
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
% Turn Windows features on or

Gl Organize v Uninstall = > B
Name : Publisher Inztalled On
[077-Zip 4.65 9/16/2014
I Microsoft NET Framework 4 Client Profile Microsoft Corporation 971772014
..j_!-hli‘:n:;oﬁ JNET Framework 4 Extended Micreseft Corporation 0/17/2014
B3 Microsoft Office Enterprise 2007 Microsoft Corporation 8/17/2014
':‘" Microsoft Office Professional Edition 2003 Microsoft Corporation 8/17/2014
7 Micresoft Visual C- + 2008 Redistributable - <86 9.0.3.. Microsoft Corporation
WJMwue Tools Wiware, Inc.

t version: 8.6.5.11214
Help link: hitpy/fwwwy

FIGURE 3-8. Add or Remove Programs (Windows 7)

3. Sclect VMware Tools and then click Remove (Windows XP or Windows Server
2003) or Uninstall (Windows 7/8/8.1/10, Windows Server 2008,/2008 R2,
Windows Server 2012/2012 R2, Windows Server 2016, or Windows Server 2019).

4. Click Yes to uninstall VMware Tools.

5. Click Yes to restart Windows.

VMware Tools is uninstalled.

Exporting Virtual Machine Images

You must verify and modify some settings before exporting a virtual machine image
from VMware ESXi or Workstation.

. Veerifying Virtual Machine Settings on V" Mware Workstation on page 3-19
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« Exporting Virtual Machine Images on V"Mware ESXi on page 3-21
Converting V"Mware ESXi Virtual Hard Disk Drives on page 3-25

Verifying Virtual Machine Settings on VMware Workstation

Procedure
1. Shut down the virtual machine.
2. In the left pane, right-click the virtual machine and then select Settings.

The Virtual Machine Settings screen appears.

Virtual Machine Setti

[l Processors: 1 | Connect at power on

et Hard Disk (IDE) 1568

) COfIVD (IDE) Auto detect Connection

[ Floppy Auto detect N

Fi Metwork Adapter  NAT 5 e pirysicad drhi:

{2 USB Controller Present | Auto detect -
) Sound Card Auto detect ) )

= Printer Use IS0 image file:

3 Display Autey detect - Browse...

FIGURE 3-9. Virtual Machine Settings
3. On the Hardware tab, verify the following:

-« CD/DVD (IDE): Connection is Use physical drive.

+  Floppy: Connection is Use physical drive.
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Virtual Machine Setti

= Memory 512 MB Connected
[ Processors 1 + | Connect at power on
CiHard Disk (IDE)  15GB
, COYIVD (IDE) Auto detect Connection
ClFopoy  Auodetea | physical arhe:
Fig Metwork Adapter  NAT bl (53
SusBController  Present [ Auto detect -
&)’ Sound Card Auto detect
) Prinker Use floppy image file
& Display Auto detect
Create... Browse...
Read-only

FIGURE 3-10. Virtual Machine Settings - Hardware

4.  Go to the Options tab and then click General.

5. In the right pane, under Working directory, locate the Virtual Machine Disk
(* . vmdk).
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Limoe

Solaris
VMware ESX
Other
Version:
| Windows XP Professional

Working directory

C:\Users\Administrator\C \Virtual Mact

1/ Suspend and snapshat files will be stored here,

Enhanced virtual keyboard
o
4\ The VMware keyboard driver is not installed on the host.

FIGURE 3-11. Working Directory

Exporting Virtual Machine Images on VMware ESXi

Procedure
1.  Shut down the virtual machine.

2. In the left pane, right-click the virtual machine and then select Edit Settings.
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(622200 v e . =~

File Edit View Inwventory Administration Plug-ins Help

G & f Home * & Inventory @ Inventory

"l eBEGHRn oD P

B 0 17222130 Bl i : = :

::j ESXI_ win7splen offic noab ESKi xDsn-_‘e.n offices_noab
Power v

Performance

-
Guest il ]
__ Snapshot re computer that, like @ Virtual Machines
@ OpenConsole loperating system and
E Sett fystem installed on a virtual
i Edit ings... perating system
Upgrade Virtual Hardware
— ine 5 an isolated computing -
Add Permission... Ctr+P  hrtual machines as deskiop or =
Report Performance 5 testing environments, or to g
- bns
Rename ts. The same host can run -
Openin New Window... CtrisAlt+N -
Remaove from Inventory kl

Delete from Disk

BATIC TSRS

| Power on the virtual machine

(» Edit virtual machine settings

Tasks root
L J

FIGURE 3-12. Edit Settings

The Virtual Machine Properties screen appears.
3. On the Hardware tab, verify the following settings:

. CD/DVD drive 1: Client Device

+  Floppy drive 1: Client Device
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~ - Virtual Machine Properties

Hardware | Ootions | Resources |

[ Show Al Devices ad.. | Remove |
Hardware Summary

o8 Memory 512 MB

@A orus 1

B video card Video card

= VMO device Restricted

= Hard disk 1 Wirtual Disk

5 C0/OVD drive 1 Client Device

B Metwork adapter 1 WM Metwork

& Floppy drive 1 Client Device

FIGURE 3-13. Virtual Machine Properties - Hardware

4. In the left pane, select the virtual machine and then go to File > Export > Export
OVF Template.
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()172.22.130 _vSphere

File | Edit View Irnventory Administration Plug-ins Help
»
o) v Inventory
Deploy OVF Template...
Export L3 Export OVF Template...
Report L Export List..
Browse VA Marketplace... Export Maps... roe Allocation | Performance | Events . Console . Permissions
Print Maps : Export System Logs...
N ‘What is a Virtual Machine?
Exit
A virtual maching is a soffware computer that, ke a Varbasl Machines
physical computer, runs an operating system and e
applications. An operating system instalied on a virtual s
machine is called a guest operating system .
Because every virtual maching s an isolated computing '(J\
environment, you can use virtual machines as desktop or =
workstation environments, as testing environments, or 10 =
consolidate server applications.
Virtual machines run on hosts. The same host can run
many virtual machines. ;.K|
Basic Tasks
¢ Power on the virtual machine
G Edit virtual machine settings
-
Tasks root
2 4

FIGURE 3-14. OVF Template

The Export OVF Template screen appears.
5.  Configure the following settings:

+  Name: Type a name for the virtual machine image.

ﬁ Note

(Optional) Click the folder icon to change the path of the OVF template files.

+  Format: Select Folder of files (OVF).

Important

Verify that Include image files attached to floppy and CD/DVD devices in the
OVF package is not selected.

6. Click OK.
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Converting VMware ESXi Virtual Hard Disk Drives

VirtualBox does not support the virtual hard disk drive format (* . vmdk) of VMware
ESXi images. Use one of the following tools to convert the disks:

. Using V" Mware vCenter Converter Standalone on page 3-25
. Using QEMU on page 3-31

Using VMware vCenter Converter Standalone

Procedure

1.  Download VMwate vCenter Converter Standalone from https://
my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/
vmware_vcenter_converter_standalone/5 5#product_downloads.

ﬁ Note

VMware vCenter Converter Standalone 5.0 does not support vCenter Server and
ESXi versions later than 5.0. Download and install a version later than 5.0.1.

2. Open VMware vCenter Converter Standalone and then click Convert machine.



https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads

Virtual Analyzer Image Preparation Tool User's Guide

le View Task Administration Help
% Convert machine & Configure machine O

View by: ~ Tasks Show: = Running tasksin ~ Recenttasks
TaskID JobID Source Destination Status Start time End time

Welcome to VMware vCenter Converter Standalone
VMware vCenter Comverter Standalone allows you to take one of a variety of machines and cornvert
it into a new VMware virtual machine. The machines you may corvert include:

Convert . ppysical machines
Maching  _ymware virtual machines (vm)
-VMware Consolidated Backup (.vmx)
- Microsoft VirtualPC's or Virtual Server virtual machines (vmc)
- Symantec LiveState Recovery Image (.sv2i)
- Acronis True Image Backup (.tib)
- StorageCraft ShadowsStor (spf)
- Parallels Virtualization Products (.pvs)
- Hyper¥ virtual machines

FIGURE 3-15. VMware vCenter Converter Standalone

The Conversion window opens.

On the Source System screen, configure the following:

a.  Select source type: Select VMware Infrastructure virtual machine.
b.  Server: Type the ESXi server IP address.

c.  User name, Password: Type the credentials that provide administrator access
to the VMware server.

Click Next.
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5.

The Source Machine screen appears.

Source Machine
Select the virtual machine you want to convert
Source System Source: & 172.22.1.30 Destination: none
Source Machine
Destination System  Inventory for: 172.22.1.30 Search for name with: Clear
Options I =
Summary ‘fM narne_ i Power state
& ESXi_win7splen_offices_noab Powered off
|5 ESXi_xpsp3en_offices_noab | Powered off
Refresh View source details...
‘ 1 13
; Help Export diagnostic logs... IL <Back J' Cancel

FIGURE 3-16. Conversion > Source Machine

Select the virtual machine that you want to convert and then click Next.
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The Destination System section appears.

Destination System
Select a host for the new virtual machine

Source System Source: @& ESXi_xpsp3en_offices_noab on 172.22.1.30 Destination: none

Source Machine . _
Destination Syste Select destination type: \U'Mware Workstation or other VMware virtual machine x|

Options Creates a new virtual machine for use on YMware Workstation, Viware
Summary Player, VMware Fusion or other VMware product.

Select VMware product: VMware Workstation 6.5 -

Virtual machine details

Name: ESXi_xpsp3en_offices_noab

Select a location for the virtual machine: ) )
¥:\for_USBox3.61\for_virtualbox\ESXi ~ Browse...

‘ 1l [

; Help Export diagnostic logs... | <Back Cancel

FIGURE 3-17. Conversion > Destination System
6. Configure the following and then click Next.

a.  Select destination type: Select VMware Workstation or other VMware
virtual machine.

b.  Select VMware product: Select VMware Workstation 6.5.x.

c.  Virtual machine details: Accept the default name and location or click
Browse to select a different file.
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The Options screen appeats.

Options
Set up the parameters for the conversion task

Source: & ESXi_xpsp3en_offic--- Destination: % Y:\for_U---\ESXi (VMware Workstation 6.0.x)
Click on an option below to edit it.

Current settings: ]
Options - Data to copy Edit
Summary Copy type: Disk-based
VirtualDisk1: 15 GB
= Devices Edit

vCPUs: 1 (1 sockets * 1 cores)
Disk controller: Auto select

Memory: 512MB

= Networks Edit
NIC1: Bridged

~ Services Edit
Total: 93 service(s)

- M Advanced options Edit

Install VMware Tools: No
Ay Customize Guest O5: NfA
Remove Restore Checkpoints: Yes
Reconfigure: Yes
=Throttling Edit
CPU: None
Network bandwidth: None

‘ 1l 3

Wl [ Help | Export diagnostic logs... [_<Backjj Next > ] [ Canceld'

FIGURE 3-18. Conversion > Options

7.  Verify the settings and then click Next.

Important

Verify that Install VMware Tools is set to No.

The Summary screen appears.




Virtual Analyzer Image Preparation Tool User's Guide

Summary
Review the conversion parameters
Source: & ESXi_xpsp3en_offic--- Destination: & Y:\for_U---\ESXi (VMware Workstation 6.0.x)
Destination System Source system information
Options Source type: VMware Infrastructure virtual machine
Summary Source VM: ESXi_»psp3en_offices_noab
Host/'Server: 172.22.1.30
Connected as: root
CPU throttiing: MNone =
Metwork throtting: Mone
Destination system information
Virtual machine name: ESXi_xpspden_offices_noab_convert v
Destination product Wiviware Workstation 6.0.x
Destination directory: Yi\for_USBod.61\or_virtualboX\ESXi
Number of vCPUs: 1 (1 sockets * 1 cores)
Physical memory: s512mB
Network: Preserve NIC count
MNIC1 Connected
Bridged connection
Disk controller type: Auto select i
Storana: . Nigk-hazad clonina
5 = R o« Hi »
Help | Export diagnostic logs... [ < Back | Finish Cancel

FIGURE 3-19. Conversion > Summary

8. Verify the information and then click Finish.
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VMware vCenter Converter Standalone converts the Virtual Machine Disk (* . vmdk).

5] vMware vCenter Converter Standalo - "

File View Task Administration Help
% Corvert machine & Configure machine O

Viewby: = Tasks Show: ~ All tasksin ~ Recent tasks

TaskiD  JobID  Source Destination Status Starttime  End time
®3 El 172221 30/E500_xpsp3en_++ \ESXi_xpsp3en offices n- [ ] 2%  2014M12/5+ Estimated time remaining: 1 hours--+

Welcome to VMware vCenter Converter Standalone

WMware vCenter Converter Standalone allows you to take one of a variety of machines and comvert
it into a new VMware virtual machine, The machines you may corvert include:

Corvert . physical machines
Machine  _ynMware virtual machines (vmx)
-VMware Consolidated Backup (vmx)
- Microsoft VirtualPC's or Virtual Server virtual machines (vmc)
- Symantec LiveState Recovery Image (.sv2i)
- Acronis True Image Backup (.tib)
- StorageCraft ShadowStor (spf)
- Parallels Virtualization Products (.pvs)
- Hyper- virtual machines

FiGURE 3-20. Image Conversion Progress

Using QEMU

For details on QEMU, see http://wiki.qemu.org/Main _Page.

Procedure

1. Download the latest version of QEMU from http://qemu.weilnetz.de/w64/.

2. Install QEMU with the default settings.

3.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

4.  Convert the Virtual Machine Disk (* . vmdk) by typing the following command:

gemu-img.exe convert [-f fmt] [-O output fmt] filename
output filename.



http://wiki.qemu.org/Main_Page
http://qemu.weilnetz.de/w64/
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For example:

"C:\Program Files\gemu\gemu-img.exe" convert -f vmdk -O vmdk
C:\ESX_xpsp3en_offices noab.vmdk C:\ESX xpsp3en offices noab_converted.vmdk

The *.vmdk file can be used to create an OVA file using VirtualBox.

Creating Virtual Machine Images Using Converted Virtual
Hard Disk Drives

Use VirtualBox to create a new virtual machine image.
«  Downloading and Installing V irtnalBox on page 2-6

« Creating Virtual Machine Images Using V'irtualBox on page 3-33

Downloading and Installing VirtualBox

Procedure

1. Download the latest version of VirtualBox from https://www.virtualbox.org/wiki

Downloads.

ﬁ Note

The VirtualBox Open Source Edition is licensed under the GPL V2. The full text of
the license is available at http://www.gnu.org/licenses/old-licenses/gpl-2.0.html.

2.  Configure the language settings using one of the following methods:

«  Install VirtualBox with English as the default language.

. After installation, go to File > Preferences > Language and then select
English.



https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
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{fi’ VirtualBox - Preferences ? ot
E General Language
@ Input Interface Languages
Default ~
@ Update English (built-in)
@ Bahasa Indonesia
Language Catals
@ Displ Cettina
Ispay Danzk
Iﬁ Metwork Deutich {Deutschland)
Esparicl
D Extensions Fuskara ~
Language: English (built-in)
Eﬁ Proxy Author(z): Orade Corporation

Cancel

FIGURE 3-21. Language Settings

Creating Virtual Machine Images Using VirtualBox

Procedure

1.  Open VirtualBox.
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The VirtualBox Manager window opens.

¥ Oracle UM VirtualBox Manager - m} X

¢ AR Gap

Preferences  Import Export New Add

File Machine Help

‘Welcome to VirtualBox!

The left part of application window contains global tools and
lists all virtual machines and virtual machine groups on your
computer. You can import, add and create new YMs using
corresponding toolbar buttons. You can popup a tools of
currently selected element using corresponding element
button.

You can press the FL key to getinstant help, or visit
www.virtualbox.org for more information and latest news.

FIGURE 3-22. VirtualBox Manager

2. Click New.
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The Create Virtual Machine window opens.

Create Virtual Machine

Name and operating system

Please choose a descriptive name and destination folder for the new virtual
machine and select the type of operating system you intend to install on it.
The name you choose will be used throughout VirtualBox to identify this

machine.
Mame: || |
Machine Folder: | D:\irtualBox YMs b |
. - L]
Type: |Microsoft Windows =4
Wio
Version: |Windows 10 (54-bit) w7
Expert Mode Mext Cancel

FIGURE 3-23. Create Virtual Machine
3. On the Name and operating system screen, configure the following:
+  Name: Type a permanent name for the virtual machine.

. Type: Select Microsoft Windows.

. Version: Select Windows XP, Windows 2003, Windows 7, Windows 8,
Windows 8.1, Windows 10, Windows 2008/2008 R2, Windows 2012/2012
R2, Windows 2016, or Windows 2019.
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4. Click Next.

The Memory size screen appears.

“  Create Virtual Machine

Memory size

Select the amount of memory (RAM) in megabytes to be allocated to the
wirtual machine.

The recommended memory size is 2048 MEB,

0 24 [ e

4 MB 32768 MB

FIGURE 3-24. Memory Size
5.  Specify the recommended memory size for your operating system.
+  Windows XP and Windows Server 2003: 512 MB

. Windows 7/8/8.1/10, Windows Server 2008,/2008 R2, Windows Server
2012/2012 R2, Windows Server 2016, and Windows Server 2019: 1024 MB

6. Click Next.
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The Hard disk screen appeats.

Create Virtual Machine

Hard disk

If you wish you can add a virtual hard disk to the new machine, You can
either create a new hard disk file or select one from the list or from another

|ocation using the folder icon.

If you need a more complex storage set-up you can skip this step and make
the changes to the machine settings once the machine is created.

The recommended size of the hard disk is 50,00 GB.

(® Do not add a virtual hard disk
() Create a virtual hard disk now
() Use an existing virtual hard disk file

Empty

FIGURE 3-25. Hard Disk

7. Select Do not add a virtual hard disk and then click Create.
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The following message appears:

¥ VirtualBox - Warning ? >

You are about to create a new

4 wvirtual machine without a hard disk.
¥ou will not be able to install an
operating system an the machine
until you add one, In the mean time
you will only be able to start the
machine using a virtual optical disk
or from the network,

FIGURE 3-26. Warning

8. Click Continue.
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VirtualBox creates the virtual machine. The new virtual machine appears in the left
pane.

W% Oracle UM VirtualBox Manager - o X

File  Machine Help

{} {3} V E&v (23 Detais . (@) Snapshots

New Settngs Dscard  Start

5| General = preview

Name: win10_office2016_x64
Operating System:  Windows 10 (64-bit)

& svstem ©
Base Memory: 1026

B
BootOrder:  Fioppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-V, Nested Paging, Hyper-V Paravirtuaization

win10_office2016_x64

Display
Video Memory:
Remote Deskiop Server: Disabled
Video Capture: Disabled

storage

Controller: SATA
SATAPortD:  [Optical Drive] Empty

B Audio

HostDriver: Windows DrectSound
Controller:  Intel HD Audio

& Network
Adspter 1: _Intel PROJ1000 T Deskiop (NAT)

5 uss

USB Controler:  OHCT
Device Fiters: 0 (0 active)

[ shared folders
None
© Description

None

FIGURE 3-27. Newly-created Virtual Machine

9. Click Settings.
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The Settings window opens.

General
System
Display
Storage
Audio
Metwork
Serial Ports
UsSB

Shared Folders

A02PPaTENEF N

User Interface

) win10_office2016_x64 - Settings

General

Basic Advanced Description Disk Encryption

Mame: |wini0_office2016_x64

Type:  Microsoft Windows

Version: | Windows 10 (64-bit)

Cancel

FIGURE 3-28. VirtualBox Settings

10. In the left pane, click System.
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1.

The System screen appears.

23 win10_office2016_x64 - Settings ? X
E General System
@ System Motherboard Processor Acceleration
|§| Display Base Memary: '
4MB 327538 MB
Storage
o]
. Boot Order: Floppy
(‘D:l Audio [©) Optical
Hard Disk
Iﬁ Network [l @ MNetwork
@ Serial Ports Chipset: | ICH9 hd
ﬁ} USB Pointing Device: |USB Tablet -
Ij Extended Features: Enable If0 APIC
Shared Fold
ared rolders [ Enable EFI (special OSes only)
EI User Interface [ Hardware Clock in UTC Time

Cance

FIGURE 3-29. System Screen

On the Motherboard tab, configure the following:
«  Chipset: Select ICH9.

. Pointing Device: Select USB Tablet.

. Extended Features:

. Select Enable I/0O APIC

. (Optional) Select Enable EFI (special OSes only) if you want to create
an EFI-compatible image. EFI-compatible images are only supported by
the following products: Deep Discovery Inspector 5.6 and later, Deep
Discovery Email Inspector 3.6 and later, Deep Discovery Analyzer 6.8




Virtual Analyzer Image Preparation Tool User's Guide

and later, Deep Discovery Director 5.1 and later, Deep Discovery Web
Inspector 2.5 and later

12. Go to the Processor tab and then select Enable PAE /NX.

13. Go to the Acceleration tab and then select Enable VI-x/AMD-V and Enable
Nested Paging.

ﬁ Note

The Acceleration tab is only available if the processor of the host system supports
virtualization technology and the virtualization setting is enabled in the BIOS of the
host system.

14. In the left pane, click Storage.

The Storage screen appears.

23 win10_office2016_x64 - Settings 7 X
E General Storage

IEI System Storage Devices Attributes

W Display & Controller: SATA @@ Name: [SATA |

@ Empty Type: |AHCI -

SRR Port Count: |2 S |
(D] Audio [ Use Host 1jO Cache

@ MNetwork

@ Serial Ports

ﬁ USE

D Shared Folders

EI User Interface

@

FIGURE 3-30. Storage Screen
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15. If Controller: SATA appears under Storage Tree, remove the SATA controller
and then add an IDE controller.

a.  Click Controller: SATA and then click @ to remove the default controller.

b.  Click ¢ and then select PIIX4 (Default IDE).

2} win10_office2016_x64 - Settings ? x
E General Storage
Ii‘ System Storage Devices Information
The Storage Tree can contain several controllers of
|§| Display different types. This machine currently has no
controllers.
Storage
(D: Audio
@ Metwork
£ serial ports £ AHCI(sATA)
ﬁ | @ PIIX4 (Default IDE)
use < PIIX3 (IDE)
lj Shared Folders @ ICHE (IDE}
@ LsiLogic (Default SCSI)
EI User Interface i
@ Buslogic (SCSI)
&5 182078 (Floppy)
& LsiLogic 5AS (SAS)
@& UsB
£ NUMe (PCle)
Qr,& virtio-scsi
Cancel

FIGURE 3-31. Add Storage Controller

c.  Click Controller: PIIX4 and then click E;
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The following window appears:

win10_office2016_x64 - Hard Disk Selector ? e
Medium

N

Add Create  Refresh

Mame Virtual Size Actual Size
v Attached
win10_office2016_x64.vmdk 25.00 GB 3.19 MB
Not Attached
Search By Name ¥ |@ Ch

FIGURE 3-32. Hard Disk Selector
d. Select the converted * . vmdk file and then click Choose.

e.  Under Attributes, change the name to IDE.
f. Under Storage Tree, click Controller: IDE and then click (g .

In the Optical Disk Selector window, click Leave Empty.

h.  Under Attributes, verify that CD/DVD Drive is IDE Secondary Master.
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€23 win10_office2016_x64 - Settings ? ®
E General Storage
IE‘ System Storage Devices Attributes
|E| Disal @ Controller: IDE Optical Drive: | IDE Secondary Master hd @l
Isplay
2] win10_office2016_x&4.vmdk [ Live co/ovD

Storage @ Empty Information

Type: —
(D] Audio b

Size: —
@ Network Location: —

Attached to: —

@ Serial Ports
ﬁ? USB
Ij Shared Folders
EI User Interface

@@=

Cnc

FIGURE 3-33. IDE Secondary Master

16. (Optional) In the left pane, click Audio and verify that Enable Audio is enabled.
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Shared Folders

23 win10_office2016_x64 - Settings ? X
E General Audio

E‘ System Enable Audio

|§| . Host Audio Driver: | Windows DirectSound A

Display
Audio Controller: | Intel HD Audio A
Storage
Extended Features: Enable Audio Output

(D:I Audio [ Enable Audio Input

@ Metwork

@ Serial Ports

ﬁ USB

User Interface

Cancel

FIGURE 3-34. Audio Options Settings
17. In the left pane, click USB and then select Enable USB Controller.

Important

Verify that USB 1.1 (OHCI) Controller is selected.
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23 win10_office2016_x64 - Settings ? X
E General uUsB
E‘ System Enable USE Controller
) (@ USB 1.1 (OHCI) Controller
|§| Display
(C) USB 2.0 (EHCI) Controller
Storage (0) USB 3.0 (xHCI) Controller
. ice Filters
(D:I Audio USE Device Fi
@ Metwork @
@ Serial Ports
ﬁ Use
D Shared Folders
EI User Interface
Cancel

FIGURE 3-35. Enable USB Controller

18. In the left pane, click Shared Folders and then verify that no folders are shared.
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Shared Folders

£ win10_office2016_x64 - Settings ? X
g

E General Shared Folders

li‘ System Shared Folders

i Mame Path Access Auto Mount At [a

|§| Display )
Machine Folders

Storage

(DJ Audio

@ Metwork

@ Serial Ports

ﬁ USB

User Interface

Cancel

FIGURE 3-36. Shared Folders Settings

19. Click OK.

The Settings window closes.

20. On the VirtualBox Manager screen, click g to power on the image.
Start
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¥ Oracle UM VirtualBox Manager - m} x

File Machine Help

B o ee ]

New Settings Discard

=] General =) preview

0 @ Powered Off Mame: win10_office2016_x64
Operating System: ~ Windows 10 (54-bit)
Settings File Location: ~ D:\Virtualbax ¥Ms
\Win10_office2015_x64

& system winl10_office2016_x64

Base Memory: 1024 ME

Boot Order:  Floppy, Optical, Hard Disk

ChipsetType:  ICH3

Acceleration:  VT-x/AMD-V, Nested Paging, PAE/NX,
Hyper-V Paravirtualization

[®) pisplay

video Memary: 128 MB
Graphics Controller: VBoxSVGA
Remote Desktop Server:  Disabled
Recording: Disabled

Storage
Controller: IDE

IDE Primary Master: win10_office2016_x64.vmdk (Normal, 25.00 GE)
IDE Secondary Master:  [Optical Drive] Empty
fp Audio

HostDriver:  Windows Directsound
Controller:  Intel HD Audio

EP Network
Adapter 1:  Intel PRO/1000 MT Desktop (NAT)

[ usB

USB Controller:  OHCI
Device Filters: 0 (0 active)

[ Shared folders
Mone
&) Description

None

FIGURE 3-37. VirtualBox Manager

21. Install Microsoft Office and other software to achieve satisfactory detection results.

Configuring Virtual Machine Images

Configure virtual machine images that were created using converted virtual hard disk
drives to avoid importing issues.

« Confignring Virtual Machine Images (Windows XP and Windows Server 2003) on page 3-50

s Configuring Virtnal Machine Inmages (Windows 7/8/8.1/ 10, Windows Server 2008/2008
R2, Windows Server 2012/2012 R2, Windows Server 2016, and Windows Server 2019) on
page 3-53
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Configuring Virtual Machine Images (Windows XP and
Windows Server 2003)

Procedure

1.

2.

On the guest operating system, click Start, right-click My Computer, and then
click Manage.

The Computer Management screen appears.

=] Computer Management E‘ @wg

=) Fie  Action  View ‘Window Help NETET
m R R

L} Computer Management (Local) Hame
= iy System Tools ESy‘ﬂm Tools
& | L] Event Viewer S storage

] Shared Folders i
Ser and Applications

+ Local Lisers and Groups & s

F

Performance Logs and Alert:
B Device Manager

# i Removable Storage
Dk, Defragmenter
Dk Management
# (1 Services and Applcations

FIGURE 3-38. Computer Management

In the left pane, click Device Manager.
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A list of devices appears.

= Computer Management

=) Fle Action View Window Help

# ) Shared Folders
xﬁwduwsw&m

Performance Logs and Alert:

=1 x|
« = W& Pm A
:-Atummmauqﬁmﬂ.ocaﬂ =
= § System Tools + 4 Eatteries
# (L] Everit Viewer ¥ 1§ Comguter
) e Dih drives

# @ Display adapters
4Lk DVDCD-ROM drives

2B} Devvice Manager + {5 Human Interface Devices
= & Storage + (=) IDE ATAATARL controbers
* Removable Storage ¥ >
Disk Defragementer #1-T7) Mice and cther pointing devices
Disk Management = HE Metwork adapbers
# [l Services and Applcations BB AMD PCNET Famiy PCI Ethernet Adapher #2
= G Other devices
3 Base System Device
1 Wideo Controller (VGA Compatible)
4 Ports (COM & LPT)
4 & Processors
+ @, Sound, video and game controllers
+ &g Sysbem devices

¥ Universal Serial Bus controllers

FIGURE 3-39. Device Management - Network Adapter Window

3. In the right pane, click Network adapters and then verify that the network
adapter driver is ready.

4.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

5. Disable the Found New Hardware Wizard by typing the following commands:
+  Windows XP 32-bit:

reg add "HKEY LOCAL MACHINE\Software\Policies\Microsoft
\Windows\DeviceInstall\Settings" /v SuppressNewHWUI /t
REG DWORD /d 1 /f

. Windows XP 64-bit or Windows Server 2003:
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reg add "HKEYiLOCALiMACHINE\SYSTEM\CurrentCOHtrOlSet
\Services\PlugPlay\Parameters" /v SuppressUI /t
REG_DWORD /d 1 /f

Found Hew Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windowrs vwill seanch for curent and updated softveaes by

Icoking on your computed, on the hasdeare instalation CD., o on
the Windows Update Wb site [with powr permission]

Fead ow pevacy pobcy

Can \Windows connect 1o Windows Updabe to search fior
sofbsare?

() ¥es. this time only
() ez, now and gveny time | cornect a device
(2 Mo not thes bme

Chek Nesd ba conlinue.

FIGURE 3-40. Found New Hardware Wizard

6. Restart the image and then verify that the Found New Hardware Wizard does
not appeat.

7. Power off the image.
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Configuring Virtual Machine Images (Windows 7/8/8.1/10,
Windows Server 2008/2008 R2, Windows Server 2012/2012
R2, Windows Server 2016, and Windows Server 2019)

Procedure

1. On the guest operating system, click Start, right-click Computer, and then click
Manage.

The Computer Management screen appears.

A Computer Management E' @[]
File Action View Help

= |0 = HE

ilﬁf Cemputer Management (Local | pame Actions
| a [} System Teels
(®) Task Scheduler
8] Event Viewer
il Shared Folders
:b_' Lecal Users and Groups
(S Perfermance

I} System Tools Computer Management (L., =
“_: Storage Mare Actions
Do Services and Applications

= Device Manager
4 2 Storage
= Digk Management
:_', Services and Applications

FIGURE 3-41. Computer Management

2. In the left pane, click Device Manager.
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A list of devices appears.

.

A Computer Management [ol @ ==
File Actien \View Help
« | 2[E HE =
_ﬁ' Computer Management (Local|| » 38 tmusbx-PC Actions
4 i} System Tools ﬁ Batteries Device Manager ad
(B Task Scheduler (B Computer
[2] Event Viewer a Disk drives Mare Actions ¥
] Shared Folders B Display adapters
& Local Users and Groups e DVD/CD-ROM drives
() Performance 8% Human Interface Devices
= Device Manager g IDE ATA/ATAPI controllers
4 B2 Storage = Keyboards
=F Disk Management P Mice and cther pointing devices
1 _-=:. Services and Applications B Monitors

LY

& Metwork adapters
i\ IntelR) PRO/1000 MT Decktop Adapter
5 Cther devices
Ui Base System Device
Y¥ Ports (COM & LPT)
n Processors

(MR System devices

W Universal Serial Bus controllers

FIGURE 3-42. Device Management - Network Adapter

3. In the right pane, click Network adapters and then verify that the network
adapter driver is ready.

4.  Power off the image.

Exporting Virtual Machine Images to OVA Files

A virtual machine image comprises many uncompressed files. The files must be
combined into a single OVA file to avoid issues when importing.

Important

Verify that the size of the created OVA file is supported by your product.

For details, go to https://docs.trendmicro.com/en-us/home.aspx#Enterprise.



https://docs.trendmicro.com/en-us/home.aspx#Enterprise
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Procedure

1. On the VirtualBox Manager screen, power off the virtual machine.

ﬁ Note

Verify that the CD/DVD drive is empty before powering off and exporting.

2.  Go to File > Export Appliance.

The Export Virtual Appliance window appears.

Export Virtual Appliance

Virtual machines to export

Please select the virtual machines that should be added to the appliance. You can select more than one. Please note that these machines have to be turned
off before they can be exported.

§8 win10_office2016 x64

Expert Mode Cancel

FIGURE 3-43. Export Virtual Appliance

3. Sclect the virtual machine image to export and click Next.




Virtual Analyzer Image Preparation Tool User's Guide

The Appliance settings screen appears.

€ Export Virtual Appliance

Appliance settings

Please choose a format to export the virtual appliance to.

The Open Virtualization Format supparts only ovf or ova extensions. If you use the ovf extension, several files will be written separately. If you use
the ova extension, all the files will be combined into one Open Virtualization Format archive,

The Oracle Cloud Infrastructure format supports exporting to remote coud servers only. Main virtual disk of each selected machine will be uploaded to
remote server,

Format: | Open Virtualization Format 1.0 -

Please choose a filename to export the virtual appliance to, Besides that you can specify a certain amount of options which affects the size and content of
resulting archive.

File: |C: Wsers\administrator \Documents\win 10_office2016_x&4.0va | Ea

MAC Address Policy: |Indude only NAT network adapter MAC addresses -
Additionally: [] Write Manifest fle
[ indude 150 image files

FIGURE 3-44. Appliance settings

4.  Configure the following:

+  File: Accept the default name and path or click :Ld to select a different file.

. Format: Select OVF 1.0.

Important

Format options include OVF 0.9, 1.0 and 2.0. Virtual Analyzer does not
support OVF 2.0.

+  MAC Address Policy: Sclect Include only NAT network adapter MAC
addresses.
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5. Click Next.

The Virtual system settings screen appears.

< Export Virtual Appliance

Virtual system settings

This is the descriptive information which will be added to the virtual appliance. You can change it by double dicking on individual lines.

Wirtual System 1
€2 Name win10_office2016_x64
@ Product
& Product-URL
@ Vendor
&) Vendor-URL
@ Version
@ Description
@ License

Restore Defaults Export Cancel

FIGURE 3-45. Virtual system settings

6.  Verify that the License field is empty and then click Export.
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VirtualBox creates the OVA file.

Iﬁ Exporting Appliance ...: Export appliance 'ChUsers] Docume...

Exporting to disk image 'win10_office2016_x&64-disk001.vmdk' ... (2/3)

B 8% X

10 minutes remaining

FIGURE 3-46. Disk Image Export Progress Bar
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Chapter 4

Virtual Analyzer Image Preparation
Tool

Learn how to use the Virtual Analyzer Image Preparation Tool in the following topics:
. Overview on page 4-2
«  Image Validation and Configuration on page 4-4

System Requirements on page 4-3

. Using the Tool on page 4-5

«  Troubleshooting Common Issues on page 4-21
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Overview

The Virtual Analyzer Image Preparation Tool facilitates the creation of custom sandbox
images.

TABLE 4-1. Features

FEATURE DESCRIPTION

Image creation Create custom sandbox images for the following products:
«  Deep Discovery Inspector 3.8 and later

«  Deep Discovery Email Inspector 2.1 and later

+  Deep Discovery Analyzer 5.1 and later

+  TippingPoint Advanced Threat Protection for Networks 3.8
SP2 and later

TippingPoint Advanced Threat Protection for Email 2.5 and
later

+  TippingPoint Advanced Threat Protection Analyzer 5.5 and
later

Deep Discovery Director 1.1 and later

Deep Discovery Web Inspector 2.0 and later

Image validation The tool validates and configures OVA files created using
and configuration VirtualBox.

ﬁ’ Note

For images created using VMware, see OVA File Creation
Using Converted Virtual Hard Disk Drives on page 3-1.
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System Requirements

TABLE 4-2. System requirements

REQUIREMENT

SPECIFICATION

Host operating
system

Build 3.8.1009 and later:
Windows 7 (32-bit and 64-bit)
Windows 8 (32-bit and 64-bit)
Windows 8.1 (32-bit and 64-bit)
Windows 10 (32-bit and 64-bit)
Build 3.8.1240 and later:
+  Windows Server 2003/2003 R2
+  Windows Server 2008/2008 R2
+  Windows Server 2012/2012 R2
+  Windows Server 2016
+  Windows Server 2019

™ Important

Microsoft .NET Framework 4.0 or later must be installed on
the host operating system.

Virtualization
application

Oracle™ VM VirtualBox 4.3 or later (except 5.0.6)

O Important

“*" The tool does not support VirtualBox 5.0.6 because a
defect prevents the first serial port from functioning
properly. Trend Micro recommends using VirtualBox 5.0.7
or later.

For virtual machine images created in VMware, see
Creating OVA Files Using Converted Virtual Hard Disk
Drives on page 3-2.
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REQUIREMENT SPECIFICATION
Hardware The hardware virtualization in the motherboard BIOS of the host
virtualization operating system must be enabled to support Windows 8/8.1/10

or any 64-bit guest operating systems.

Note

The tool can detect hardware virtualization only on
Windows 8/8.1/10 hosts.

Image Validation and Configuration

The tool automatically validates and configures the following VirtualBox image settings.

TABLE 4-3. Validating and configuring image settings

SETTING CORRECT CONFIGURATION
Admin password 1111
Keyboard layout Enhanced keyboard layout: 101
Found New Hardware Disabled
Wizard
Disk defragmentation Disabled
.NET Optimization Disabled
CPU count 1
Memory size +  Windows XP or Windows Server 2003: 512 MB
+  Other operating systems: 1024 MB
PAE/NX Enabled
Hardware virtualization VT-x/AMD-V and nested paging enabled
Audio driver Enabled
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SETTING CORRECT CONFIGURATION

Windows SMB service Enabled
(TCP port 445)

File and Printer Sharing for | Enabled
Microsoft Networks

AutoPlay Enabled in Windows 7/8/8.1/10
Default web browser Internet Explorer

Microsoft Office macros Enabled

Network adapter settings Obtain an IP address automatically

O Important
L *

The tool checks but does not modify the Windows and Office versions. Verify that the
image meets the requirements before running the tool.

Using the Tool

Procedure

1.  Obtain a copy of SandboxWizard. zip from your support provider.

2.  Extract the package content to a local folder. Go to the folder and then open
SandboxWizard.exe.
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The introduction screen appears.

Virtual Analyzer Image Preparation Tool — O *

Virtual Analyzer Image Preparation Tool

The Virtual Analyzer Image Preparation Tool facilitates the creation of custom sandbox images.
Important: Using this tool may decrement Windows and Office activations,

View the readme

v3.8.1014 (c) 2020 Trend Micro Inc

FIGURE 4-1. Introduction screen

3. C(lick Next.
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The License Agreement screen appears.

Virtual Analyzer Image Preparation Tool — O *

License Agreement

Please read the following license agreement carefully.

TREND MICRO END USER AGREEMENT

Software/Service: Trend Micro Tools and Services

Wersion: English/Multi-country

Date: May 2019

Important: These terms and conditions governs your use of the Trend Micro software ("Software”)
and/or service ("Service") and any and all related documentation, and updates and upgrades that
replace or supplement the Software and/or Service in any respect and which are not distributed with
a separate license (“Agreement”). By downloading or otherwise accessing the Software and/or
Service, you agree to be bound by this Agreement and have reviewed our Global Privacy Motice at
https://www.trendmicro.com/en_us/about/legal/privacy-palicy-product.html.

Trend Micre Incorporated ("Trend Micra”) reserves the right to amend these terms at any time at
Trend Micro's sole and exclusive discretion by posting such changes on Trend Micro's website:
https://www.trendmicro.com/en_us/about/legalhtml. The amended terms shall be effective as of
the date posted. It is your responsibility to check the website to learn of these medifications. You
agree to be bound to the terms of the Agreement, as modified.

YOU MUST BE AT LEAST 18 YEARS QLD AND HAVE ATTAINED THE AGE OF MAJORITY IN THE STATE,
PROVINCE OR COUNTRY WHERE ¥OU LIVE TO EMTER INTO THIS AGREEMENT. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE.

| accept the terms of the license agreement

ce <Back Mext:

FIGURE 4-2. License Agreement screen

Read the license agreement. If you agree with the terms, select I accept the terms
of the license agreement and then click Next.

The tool checks if the computer meets the system requirements, and then the
System Requirements screen appears.
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Virtual Analyzer Image Preparation Tool - O *

System Requirements

@ All requirements have been met. Click Next to continue using the tool,

Mote: The Teol can detect hardware virtualization only on Windows 8 or later hosts.

VirtualBox 4.3 or newer: 6.1.10

CPU hardware virtualization: Enabled

nce | <Back | Mext>

FIGURE 4-3. System Requirements screen

5. Click Next.
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The Specify Virtual Machine screen appears.

Virtual Analyzer Image Preparation Tool - O *

Specify Virtual Machine

The tool will check the image for required applications, and then adjust settings if
necessary.

Important: Using this tool may decrement Windows and Office activations. It is

recommended to activate the products in the guest operating system to ensure normal
operation of the image.

® Use an OVA image (exported from VirtualBox)

) Select a VM on VirtualBox

OWA file: Browse

Mote: The tool will import the selected OWA file into VirtualBox for validation
and preparation. Depending on the size of the OVA file, the resulting VM can
consume several gigabytes of disk space.

FIGURE 4-4. Specify Virtual Machine screen
6.  Specify an OVA file or a virtual machine instance running on VirtualBox.

a.  Select one of the following:

+  Use an OVA image (exported from VirtualBox): Select this option if
you converted a VMwate image and then packaged it as an OVA file. For
details, see OVZA File Creation Using Converted V'irtual Hard Disk Drives on
page 3-1.
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O Important
o

Open Virtualization Format (OVF) is a cross-platform standard for
packaging and distributing software to be run in virtual machines. OVF
enables the creation of ready-to-use software packages (operating systems
with applications) that require no configuration or installation.

An OVF package consists of several files that can be packed into a single
archive file with the extension . ova. Virtual Analyzer supports only
image files in the OVA format.

. Select a VM on VirtualBox: Select this option if you want to create an

image based on an existing virtual machine on VirtualBox.
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For example:

Virtual Analyzer Image Preparation Tool - O *

Specify Virtual Machine

The tool will check the image for required applications, and then adjust settings if
necessary.

Impertant: Using this tool may decrement Windows and Office activations. Itis
recommended to activate the products in the guest operating system to ensurs normal
operation of the image.

() Use an OVA image (exported from VirtualBox)

® Select a VM on VirtualBox

VirtualBox VM: | win10_office_x64

Clone VM before processing

nce Mext>

FIGURE 4-5. Specify Virtual Machine screen - Select a VM on
VirtualBox

b.  Seclect Clone VM before processing to create a new copy of the virtual
machine with its own set of individual snapshots. Cloning allows quick
creation of duplicate environments for testing. You can run as many clones as
the memory and processors on the system allow.

7. Click Next.
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The Sandbox Preparation screen appeats.

tual Analyzer Image Preparation Too

Sandbox Preparation

29% complete..

Importing the image to VirtualBox...
Attaching the serial port...

Checking the wirtual machine settings...
Powering up the virtual machine...
Checking a few Windows settings...

<Back Mext=

FIGURE 4-6. Sandbox Preparation screen

The tool modifies incorrectly configured settings. For a list of settings that the tool
validates, see Image Validation and Confignration on page 4-4. For solutions to issues
that occur during this phase, see Troubleshooting Common Issues on page 4-21.

Perform one of the following actions depending on the screen that appeats:
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+  The Sandbox Ready screen appears when the tool has successfully validated
and configured all settings.

O

sandbox Ready

A valid image has been prepared successfully. Export the image to an OVA file now or use
VirtualBox to export it later.

Original image file:  7_En_win10rs3en_offices_noab.ova

Windows: Microsoft Windows 10 Pro Build 16299 32bit

VM settings: Done

Internet Explorer.  Internet Explorer 11.15.16239.0

Office: Office 2013,2016

Adobe Reader: Adobe Reader 11.0.02

Adobe Flash: Adobe Flash Player Active ¥ 18.0.0.203
.NET: NET Framewark 4.7.02556

Wiew detailed log

I

<Back Mext>

o
=
a

FIGURE 4-7. Sandbox Ready screen

Click Next to continue.
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. The Products Not Activated screen appears when the tool detects that
Windows and/or Office are installed but not activated.

Virtual Analyzer Image Preparation Tool - O *

Products Mot Activated

Windows and/or Office are not activated. It is recommended to activate the products in
the guest operating system to ensure normal operation of the image. Click Retry after
activating the products.

How to activate products

Original image file:  MAK_ID25_win10en_offices_noab_x64.ova

e Microsoft Windows 10 Enterprise Build 10240 84bit (not
activated)
VM settings: Done

Internet Explorer.  Internet Explorer 11.0.10240.16384

Office: Office 2010,2013 (not activated)
Adobe Reader Adobe Reader (will be installed)
Adobe Flash: Adobe Flash Player Active ¥ 18.0.0.203
NET: .NET Framewark 4.6.00079

View detailed log

Cance <Back Mext>

FIGURE 4-8. Products Not Activated screen
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Click How to activate products to learn to how to activate Windows and/or
Office in the guest operating system.

How to activate products >

Step 1: Switch to VirtualBox and activate Windows and/or Office,
Step 2: Switch to the Virtual Analyzer Image Preparation Tool,
Step 3: Click Retry.

OK

FIGURE 4-9. How to activate products dialog

Click Retry after activating the products, or click Next to continue without
activating the products. It is recommended to activate the products in the
guest operating system to ensure normal operation of the image.
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The Sandbox Preparation Unsuccessful screen appears when the tool is
unable to fix issues encountered during preparation.

Virtual Analyzer Image Preparation Tool

Sandbox Preparation Unsuccessful

® One or more Office products are not installed. Trend Micro recommends installing all Office
products in the guest operating system to ensure normal operation of the image.

WM Name; MAK_ID27_win10t2en_offices_noab
Windows: Microscft Windows 10 Enterprise Build 10586 32bit
WM settings: Daone

Internet Explorer:  Internet Explorer 11.103.10586.0

Office: Office (not installed)
Adobe Reader: Adobe Reader (will be ins
Adobe Flash: Adobe Flash Player Active X 18.0.0.203
.NET: NET Framework 4.6.01038
View detailed log Retry
| Cancel | | <Back MNexts

FIGURE 4-10. Sandbox Preparation Unsuccessful screen

Click View detailed log and perform any recommended actions before
running the tool again.

Click Retry to try preparing the sandbox again, or Cancel to exit the tool.
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If no issues arise, the Specify the OVA image path and file name screen
appears.

Virtual Analyzer Image Preparation Tool - O *

Specify the OVA image path and file name

Specify a path and file name for the new image. By default, the image is saved in the same
folder as the tool.

Path and file name: | CAVAIPT ova\[VAIPTIwin10_rs2_office_2016_x64ova ||

Estimated image size: 8G

104 GB on diskiC)

Available disk space:
0 GB on disk(F:\)

Remove the image from VirtualBox after exporting
[] Compress the image for uploading to Deep Discovery Director

ce <Back Mext=

FIGURE 4-11. Specify OVA image path and file name screen

If issues arise and are not resolved, see Troubleshooting Commuon Issues on page 4-21.
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ﬁ Note

SandboxWizard.exe saves logs in the \1og folder where you run the tool. Logs
use the following naming convention: d: \SandboxWizard\log\VATool~
yyyymmddhhmmss output.txt

For example: d: \SandboxWizard\log
\VAT001-20170925025520_output.txt

9. Configure the following settings:

«  Specify the path and file name that the tool uses when saving the OVA file.

ﬁ’ Note

The tool uses the following naming convention when saving an OVA file:
VAT001-20170925025520.0va

. (Optional) Enable Remove the image from VirtualBox after exporting.

Disable this option if you want to keep the image in VirtualBox even after
exporting,

Important

Unused images consume valuable disk space may impact performance.

+  (Optional) Enable Compress the image for uploading to Deep Discovery
Director.

Important

Only Virtual Analyzer images compressed in TAR format by the Virtual
Analyzer Image Preparation Tool can be uploaded to and deployed from Deep
Discovery Director.

10. Click Next.




Virtual Analyzer Image Preparation Tool

The Export the image to OVA screen appears and the tool exports the OVA file.

Virtual Analyzer Image Preparation Tool - O *

Exporting the image to OVA...

8% complete..

Cancel <Back MNext>

FIGURE 4-12. Export the image to OVA screen
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1.

The OVA Image Ready screen appears when the export process completes.

Virtual Analyzer Image Preparation Tool — O *

OVA Image Ready

@ The OVA image file has been created successfully. The image is ready for use in Virtual

Analyzer.

Image file: CAD\VAIPT ova\VATool-20171011103003.0va
Windows: Microseft Windows 10 Enterprise Build 15063 64bit
VM settings: Done

Internet Explorer:  Internet Explorer 11.0.15063.0

Office: Office 2016

Adobe Readen Adobe Reader 8.9 11 (will be installed)
Adobe Flash: Adobe Flash Player Active ¥ 18.0.0.203
MNET: JMET Framework 4.7.02046

Back to Home <Back Mext>

FIGURE 4-13. OVA Image Ready screen

Click the Close button in the upper right corner to exit the tool or click Back to
Home to create another image.
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Troubleshooting Common Issues

TABLE 4-4. Common Issues When Using the Tool

ISSUE

CAUSE

RECOMMENDED ACTION

Unable to upload an
OVA file.

The image does not
meet the minimum
or maximum size
requirements.

Verify that the size of the OVA file is
supported by your product.

Unable to prepare a
virtual machine
image.

The image was not
created using
VirtualBox.

VirtualBox is not
installed on the
computer.

Install a supported VirtualBox version. For
details, see System Requirements on page
4-3.

For virtual machine images created in
VMware, see Creating OVA Files Using
Converted Virtual Hard Disk Drives on
page 3-2.

The image uses an
unsupported
operating system.

Use a supported operating system. For
details, see Required Software on page
2-2.

VirtualBox is
unresponsive.

Refer to the VirtualBox documentation.

https://www.virtualbox.org/manual/
ch12.html#idp54271008



https://www.virtualbox.org/manual/ch12.html#idp54271008
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ISSUE CAUSE RECOMMENDED ACTION
Unabile to start the Settings are Open the imported image using VirtualBox
VirtualBox incorrectly and verify the following Storage settings.
installation CD/ configured. .
DVD. «  Select Controller: IDE and verify that

the specified type is PIIX4.

@ winl0_ffce2016.x4 - Setings T x

T Use Fost1/0 Cache

BEQS
o[ o

FIGURE 4-14. Controller: IDE must
be set to PlIX4

Select the optical disc icon and verify
that the specified CD/DVD drive is
IDE Secondary Master.

23 win10_office2016.164 - Setings 7 X

BEe

FIGURE 4-15. CD/DVD drive is set to
IDE Secondary Master
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ISSUE CAUSE RECOMMENDED ACTION
Unable to enter the | Group policy Click OK on the Virtual Analyzer Image
desktop of the guest | settings are Preparation Tool Test screen to enter the
operating system. incorrectly desktop of the guest operating system.
configured.

. Windows 7 Professional
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IssuE CAUSE RECOMMENDED ACTION

Unabile to start AutoPlay settings 1. Open VirtualBox.
SandboxWizard.exe | are incorrectly

in the guest image. configured. 2. On the VirtualBox Manager screen,

click ;ﬁ to power on the image.

3. On the guest operating system,
perform the following:

a. Go to Control Panel > Hardware
and Sound > AutoPlay.

b. Select Install or run program
from your media from the
Software and games drop-down
menu.

c. Click Save.

d. Open the Local Group Policy
Editor.

e. Go to Computer Configuration >
Administrative Templates >
Windows Components >
AutoPlay Policies.

f.  Select Not configured to disable
AutoPlay.
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Sample Logs
Preparation successful. Missing app detected.

Trend Micro Inc(TM) Virtual Analyzer Image Preparation Tool
Detailed Log

Result Preparation successful
Completed 2019-12-13 83:43:13
Virtual machine name VATool-208191213832818(in VirtualBox) - 0K

2. Hardware settings

Processor Count 1 - 0K

Memory Size 1824 - 0K
Host Audio Driver "dsound” - 0K
Audio Controller "dsound” - 0K
Nested Paging "on™ - 0K
Large Page "on™ - 0K
CPU Execution Cap 1ee - 0K
PAE/NX "on™ - 0K
ACPI "on™ - 0K
HPET "off" - 0K
I/0 APIC "on™ - 0K
Use UTC "off" - 0K
Chipset "ichg" - 0K
UsB "on™ - 0K
USB ECHI "off" - 0K
VT-x "on™ - 0K
Pointing Device "usbtablet™ - 0K
NIC "nat” - 0K
IDE Controller - 0K
CD/DVD drive - 0K
VMDK /VDI - 0K

3. Windows and applications”

Windows Microsoft Windows 1@ Enterprise Build 17134 32bit - OK
Office
2013 Microsoft Excel 2013 - 0K
Microsoft PowerPoint 2013 - 0K
Microsoft Word 2013 - 0K
Microsoft Publisher 2013 - 0K
2016 Microsoft Excel 2816 - 0K
Microsoft PowerPoint 2016 - 0K
Microsoft Word 2816 - 0K
Microsoft Publisher 2016 - 0K
-NET .NET Framework 4.7.83856 - 0K
Internet Explorer Internet Explorer 11,112.17134.80 - 0K
Adobe Flash Adobe Flash Player Active X 38.0.0.113 - 0K

Adobe Reader Adobe Reader - will be installed
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Preparation unsuccessful. Some items must be fixed manually.

Trend Micro Inc(TM) Virtual Analyzer Image Preparation Tool
Detailed Log

Result Preparation unsuccessful. Some items need to be fixed manually.
Error Reason One or more Office products are not installed.

Completed 2019-12-13 ©9:44:45

Virtual machine name VATo01-20191213092157(in VirtualBox) - 0K

2. Hardware settings

Processor Count 1 - 0K
Memory Size 1024 - 0K
Host Audio Driver "null” - 0K
Audio Controller "null” - 0K
Nested Paging "on™ - 0K
Large Page "off" - 0K
CPU Execution Cap 1ee - 0K
PAE/NX "on"™ - 0K
ACPT "on™ - 0K
HPET "on™ - 0K
I1/0 APIC "on™ - 0K
Use UTC "off" - 0K
Chipset "ichg” - 0K
UsB "on™ - 0K
USB ECHI "off" - 0K
VT-x "on™ - 0K
Pointing Device "usbtablet™ - 0K
NIC "natnetwork” - 0K
NAT Metwork "NatNetwork"” - 0K
IDE Controller - 0K
CD/DVD drive - 0K
VMDK/VDI - 0K

3. Windows and applications™

Windows Microsoft Windows 18 Enterprise Build 17134 64bit - Installed
Office
2019 Microsoft Excel 2019 - Installed

Microsoft PowerPoint 2019 - Error: not installed
Microsoft Word 2019 - Error: not installed
Microsoft Publisher 2019 - Installed

WNET CNET Framework 4.7.83856 - 0K

Internet Explorer Internet Explorer 11.112.17134.8 - 0K

Adebe Flash Adobe Flash Player Active X 32.6.0.207 - 0K

Adobe Reader Adobe Reader - will be installed
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